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Introduction 
OpenBook User’s Guide 

About this Guide 
The OpenBook User’s Guide teaches you to use and 
customize OpenBook’s scanning and reading capabilities to 
fit your personal needs. 

The first book, the Quick Start Guide, gives you the basics to 
get up and running with OpenBook. Following the Quick 
Start Guide are more books that give complete instructions 
to all of OpenBook’s features. Finally you will find a list of 
keystrokes for quick reference. These keystroke are also 
available in the back of the print and Braille Quick Start 
Guide as perforated reference cards. 

However you decide to use this guide, we will lead you to a 
more productive computing experience with this scanning 
and reading software. 

Documentation Conventions 
In the OpenBook User’s Guide we will refer to various 
commands, menu options, and other selections. To make 
reading this guide as simple as possible, we have included a 
sample of the following conventions. 

When instructing you to type text into a command line or 
input field, the text will appear in this type style: 
C:\Openbk7\Obu.exe. 
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A hot key is a combination of keys pressed on the keyboard, 
which invokes the same response regardless of the 
application you are currently using. A hot key can be a single 
key on the keyboard, but more commonly it is several keys 
pressed in combination. For example, ALT+CTRL+O 
requires you to press all three keys simultaneously. 

Alternatively, shortcut keys invoke a different action 
depending on the application in which you are currently 
working. Shortcut keys also can be one key or multiple keys 
pressed in combination. Shortcut keys may also require you 
to press a sequence of keys, such as ALT+F, O. In this 
case, you would press the ALT key and the F key, release 
them, and then press the O key. These hot keys and 
shortcut keys will appear in bold text throughout the User’s 
Guide. 

Another convention we use in this Guide is the reference 
regarding the active state of an item. When we refer to an 
item in the active state, we mean that OpenBook is focusing 
on the item and certain keystrokes performed affect that 
item. OpenBook gives both auditory and visual feedback to 
indicate the active state. 
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Book 1 
Quick Start to OpenBook 

Welcome to OpenBook 
OpenBook is a software program that transforms your 
personal computer and scanner into a full-featured reading 
machine. Use any of today’s popular scanners to scan your 
favorite magazine, book, or newspaper article, and let 
OpenBook read that page aloud to you. Or open an 
electronic file from any of today’s most popular applications 
and edit at will. With OpenBook nothing is left inaccessible 
and even better, you are in control of how a page is read and 
presented on your computer screen. 

System Requirements 
The recommended system requirements for OpenBook 
include a personal computer with Windows 9x, Me, NT 4.0 
with Service Pack 6, 2000, or Windows XP Pro/Home. 

Specification Minimum Requirement 
Processor speed 166 MHz 
RAM 32 MB 
Available hard disk space 460 MB 
for installation 
Video Super VGA display 
Sound Windows compatible sound 

card and speakers 
Keyboard 104 key Keyboard 
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Specification Minimum Requirement 
Scanner A supported TWAIN­

compatible scanner or a 
supported Hewlett-Packard 
flatbed scanner 

CD ROM Drive 

Installing OpenBook 
1. 	 Insert the OpenBook CD into your CD-ROM drive. 
2. 	 The OpenBook Setup program starts. You will hear the 

installation speak the instructions as they appear on 
your screen. Follow these instructions to complete the 
OpenBook installation. 

Note: 	 Have your software serial number handy. The serial 
number is located on the outside of the box and on the 
outside of OpenBook’s CD jacket. When you type in 
your serial number be sure to include any dashes. 

If your OpenBook installation CD does not start 
automatically, go to the Start button, select Run, and type 
D:\setup. If your CD-ROM drive is not D, substitute the 
correct drive letter. 

The OpenBook setup program will then begin. 
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Choose to run the Typical or Custom installation of 
OpenBook. The Typical installation assumes that you want 
to install the default files along with ViaVoice™ and 
RealSpeak™ text-to-speech software (TTS), that you 
approve of OpenBook’s default location on your hard drive, 
and that you want the standard launchable programs 
installed. Use the Custom installation, if you want to use a 
different synthesizer, specify which languages are installed, 
and/or specify where OpenBook is stored on your hard drive.  

Note: 	 When you install OpenBook your scanner is 
automatically detected. 

Installing Connect Outloud 
During OpenBook installation you will be asked if you would 
like to install Connect Outloud. Installing Connect Outloud 
with OpenBook provides you with speech and Braille access 
to the Windows Operating System and many components 
installed as part of that system including Internet Explorer 
and Outlook Express. The new Connect Outloud also 
provides speech support for Adobe® Acrobat Reader. 

If you currently have a Screen Reading product installed, it is 
recommended that you do not install Connect Outloud 
without consulting the manufacturer of your Screen Reader 
product. 

Uninstalling OpenBook 
To uninstall OpenBook go to the Programs Menu and select 
OpenBook 7.0. In the Tools submenu select the Uninstall 
OpenBook option. Uninstalling OpenBook does not uninstall 
Connect Outloud. If you choose to leave Connect Outloud on 
your computer system, it will run as a demo. 
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Uninstalling Connect Outloud 
To uninstall Connect Outloud go to the Programs Menu and 
select Connect Outloud 2.0. In the Tools submenu select the 
Uninstall Connect Outloud option. 

Registering OpenBook 
Initial Registration 

Once you have completed the installation of OpenBook, you 
are ready to register your software license with Freedom 
Scientific. 

We encourage you to register your software. Registering 
your software costs you nothing, takes just a few minutes, 
and is the best way for you to receive quality service. Failing 
to register your software prevents us from providing you with 
technical support. 

To register: 
1. 	 Place the Registration disk in your disk drive. 
2. 	 Start OpenBook if it is not already running. 
3. 	 Go to the File Menu and select Open or press 


CTRL+O. 

4. 	 Type in the Filename edit box, a:\registration.ark and 

then press ENTER. 
5. 	 The registration document will open. 
6. 	Press CTRL+E to toggle to the Edit Mode in OpenBook. 
7. 	Use your ARROW keys to move down the screen and 

fill in the information requested. 
8. 	 When finished, save the information by pressing 

CTRL+S. 
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Note:	 To save a copy of this form on your computer, press 
ALT+F, A (for Save As) and then press ENTER. This 
saves a copy of the same file in the default folder on 
your hard drive. 

9. 	 If you live in the United States you can send the disk to 
Freedom Scientific in the self-addressed diskette 
envelope included in the software package. (This 
cardboard diskette envelope has the name Freedom 
Scientific embossed in Grade 2 Braille.) 

Changing Your Registration 
If you need to change your registration information, such as 
your address or phone number, open the Registration.ark file 
located on your hard drive under C:\Openbk7. The same 
questions appear as your initial registration. Change the 
necessary information, save it to a 3.5 floppy and send it to 
Freedom Scientific. 

Getting Started 
Launching OpenBook 

OpenBook gives you a variety of ways to launch the 
program. 
•	 Press the hot key, ALT+CTRL+O, which is 

automatically assigned when you install OpenBook. 
•	 Double-click the OpenBook icon on your desktop. 
•	 Go to the Start menu and select Programs. Choose 

OpenBook 7.0 from the OpenBook 7.0 menu. 
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Once launched, OpenBook opens with a blank untitled 
document from which you can begin working or if you prefer, 
you can change the startup document to be the document 
you were working on last. To do this, go to the Settings 
Menu and select General Settings (ALT+G, G). In the 
General Settings Dialog, press TAB until you arrive on the 
Open Untitled Document on Startup radio button. Press the 
DOWN ARROW key to select the Open Last Document on 
Startup radio button. If you want to make more setting 
changes press ALT+A or TAB to the Apply button and press 
the SPACEBAR. Exit this properties page by pressing 
ENTER. Next, to change the settings so that OpenBook is 
always in this Mode, open the Settings Menu again 
(ALT+G). From the Menu, choose Save the Settings... . In 
the Save Settings dialog, press ENTER to make the 
changes part of the default settings. For more information on 
this feature, please see the book, Using Setting Files. 

Closing OpenBook 
You can close OpenBook like any other Windows application 
by pressing ALT+F4, point the mouse and left click on the X 
in the top right hand corner of the window, or select Exit from 
the File menu. 

Scanning and Reading 
OpenBook combines the best in scanning and reading 
features to convert printed media into electronic format. It 
then displays and reads the content aloud giving you access 
to material that would otherwise be inaccessible or difficult to 
read. 
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When you install OpenBook, IBM’s ViaVoice or ScanSoft’s 
RealSpeak TTS software is also installed. You can scan, edit 
or read a document. Additionally, you can customize the 
scanning, reading, and display properties of OpenBook. 

Here are a few shortcut keys to get you started with 
OpenBook. 
•	 To have OpenBook read to you, press NUM PAD 

ENTER, F10, or F12. 
•	 To scan, press NUM PAD INSERT, SPACEBAR, or F4. 
•	 To toggle between Edit Mode and Read-only Mode, 

press CTRL+E. 
•	 To silence speech press the CTRL key. 
•	 To read faster, press CTRL+2. 
•	 To read slower, press CTRL+1. 

Getting Help 
Online Help System 

OpenBook’s Online Help System consists of three 
components, the Contents page with its tree view of books 
and topics, the Index page with its alphabetical listing of 
topics, and the Text View, which displays all topic content. 
When you launch Help, OpenBook automatically begins 
reading the contents of the Text View. To stop reading, press 
the CTRL key. To move from the Text View to the Tree View 
of books and topics, press F6. To return and begin reading 
the contents in the Text View, press F6 again. 
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To navigate the books in the tree, use the UP and DOWN 
ARROW keys. The RIGHT ARROW key expands books to 
display the topics, while the LEFT ARROW key closes 
books. When you find the topic you want to read, press 
ENTER on the standard keypad. OpenBook Help displays 
that topic and automatically begins reading the contents. 

Note: To display the selected topic in the Text View, you must 
press ENTER. Simply moving back to the Text View 
without pressing ENTER does not display or read the 
newly selected topic. 

The Index page is particularly helpful if you are searching a 
particular topic because it lists help topics in alphabetical 
order. To move between the Contents and the Index pages 
of Help, press CTRL+TAB. 

Navigating the Index’s list of topics is similar to navigating 
the Tree View of the Contents page in that you can use the 
UP and DOWN ARROW keys to move you up and down the 
list of topics. Or if you know the topic you want to find, type 
its first letter. For instance, you want information on the 
Zoom feature of OpenBook. You would then type the letter Z. 
The Index automatically moves through the list to that topic 
or to a topic that begins with the letter Z. 
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You can also navigate OpenBook’s Help System by pressing 
the TAB key. When you press the TAB key, you cycle 
between the three controls in Help. Pressing the TAB key 
once activates the Tree View or Index list, use the ARROW 
keys to navigate or open and close topics. Pressing the TAB 
key twice, activates the Tab Control on the Contents or 
Index page, use the LEFT and RIGHT ARROW keys to 
switch between the Contents or Index page. Pressing the 
TAB key again activates the Text View where the topic 
contents are displayed. Here you can press F12 to read or 
the ARROW keys to navigate the contents. 

Context-Sensitive Help 
When you are in a dialog box, press SHIFT+F1 or the NUM 
PAD MINUS key to read the context-sensitive help message 
for the current item. 

You can also access context-sensitive help by right clicking 
the mouse on a control and selecting “What’s This” or by 
clicking on the ? (question mark) symbol at the top right 
corner of the dialog box and then clicking on a control. 

OpenBook User’s Guide 
We provide you with the content of the OpenBook Online 
Help System in the OpenBook User’s Guide, which uses 
large text for easy reading. The manual contains the Quick 
Start Guide, a detailed description of OpenBook’s features, 
and pull out reference cards. 
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Technical Support 
If you do not find the answers to questions or problems that 
you have, contact Freedom Scientific Technical Support, 
(727) 803-8600 or e-mail Support@FreedomScientific.com. 
Office hours are from Monday through Friday 8:30 A.M. to 
7:00 P.M. Eastern Standard Time. 

Please have the following information on hand: 

• Product serial number used for registration. 
• Product name and version number. 
• Type of computer hardware you are using. 
• Software version number of Windows. 

About OpenBook 
Select About OpenBook from the Help menu on the 
OpenBook user interface to view the version number of 
OpenBook you are currently running and its serial number. 
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Book 2 
Navigating OpenBook 

Use Your Keyboard or Your Mouse 
With OpenBook, you can use your mouse or your keyboard 
to access most features. Many people use a combination of 
the two. The OpenBook documentation gives you 
information on performing actions with both the keyboard 
and the mouse. For example, you can either press ALT+F to 
access the File menu, or you can point and click the word 
File with the mouse. 

Using the Keyboard with OpenBook 
OpenBook uses many Microsoft Windows® keyboard 
commands. For instance, special keys such as ALT, CTRL, 
SHIFT, TAB, and INSERT are often combined with the 
Function Keys i.e., F1 through F12, to perform specific 
operations such as closing an application (ALT+F4). 

Special keys can also be combined with a letter to invoke a 
command for example, CTRL+S, which saves the current 
document without closing it. Or they can be combined with 
letters assigned to features such as ALT+S, which accesses 
the Scan menu. 

By default, OpenBook does not announce these keystrokes, 
also known as shortcut keys and access keys. 
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To have OpenBook announce these keystrokes, type the 
following: ALT+G, G, ALT+K. This takes you to the General 
Settings Properties page. After you press ALT+K, 
OpenBook should say "Announce Shortcut and Access 
Keys: checked.” Press ENTER to save the settings and 
close the dialog box. 

Tip: The underlined letter on a menu, a command button, or 
a dialog option identifies the Access key, while Shortcut 
keys usually correspond to a command name on a 
menu. 

If you are unsure how an item or control works you can 
activate context sensitive help with the F1 on the keyboard. 
To use this feature press the TAB key to move to the button 
that you want to see the help for and press the F1. 

Alternate Keyboard Layouts 
OpenBook provides alternate keyboard layouts to make it 
easier to use OpenBook together with popular assistive 
technology products. The JAWS keyboard layout is 
optimized for use with the JAWS for Windows screen reader 
from Freedom Scientific. The Window- Eyes keyboard layout 
is optimized for use with the Window-Eyes screen reader 
from GW Micro. 

To change the keyboard layout: 
1. 	Press ALT+G to open the Settings menu. 
2. 	Press K to open the Keyboard Settings dialog. 
3. 	 When this dialog opens, the Keyboard Layout combo 

box is active. 
4. 	Use UP or DOWN ARROW to locate the keyboard 

layout you want to use. 
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5. TAB to the Ok button and press SPACEBAR. 

Using the Mouse with OpenBook 
Point & Click 
With OpenBook you don’t have to learn keystrokes to 
perform actions. You can use the mouse to point at items on 
the user interface, and click the buttons to activate features. 
For example, if you are in a dialog, you can use your mouse 
to click directly on any option in the dialog to select it. 

If you are not sure how to activate a feature, use your mouse 
to open the menus and find the feature you need. 

Left Click vs. Right Click 
The left mouse button is the more commonly used mouse 
button because it activates menus and buttons. 

Alternatively, the right mouse button provides useful 
shortcuts to many items found under OpenBook’s menus. 
Right click on the user interface to see a context menu or 
right click on a button to view context sensitive help. To use 
the context sensitive help feature, move the mouse to the 
control you want help on and right click. A “What's This” 
button appears. Move you mouse over this button and click 
the left mouse button to have OpenBook open and read the 
context sensitive help topic. 
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Book 3 
User Interface, Dialogs & Controls 

Introduction to the User Interface 
The user interface automatically opens when you launch 
OpenBook. To open the program, press ALT+CTRL+O or 
select it in the Programs Menu. 

The OpenBook user interface consists of the Title Bar, the 
Menu Bar, the Document Window, the Status Bar, and the 
Scroll Bar. 

You can work in other applications without closing the 
OpenBook program by using ALT+TAB. When you want to 
return to OpenBook, press ALT+TAB again. If you have 
more than two applications opened at the same time, you 
hold the ALT key down while you press the TAB key until 
you reach the application you want to work in. 

Title Bar 
The Title Bar is the blue bar across the top of the application, 
which says, “OpenBook – [name of the file/document].” 
Locate the OpenBook Title Bar at the very top of the window. 
Press NUM PAD 7 to hear the text of the Title Bar. 

To open the Application System Menu, press 
ALT+SPACEBAR, or click the OpenBook icon on the left 
side of the Title Bar. 

The Application Menu contains six items: 
•	 Restore – This item restores the application window to 

its previous size and location. 
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•	 Move – With this item you can change the location of 
the application window. 

•	 Size – This item lets you change the size of the 

application window. 


•	 Minimize – This item reduces the application window to 
an icon. 

•	 Maximize – This item enlarges the application window 
so that it fills the screen. 

•	 Close – This item closes the application window. 

(ALT+F4) 


Located on the right side of the Title Bar are three small 
icons. These icons provide an alternative way to minimize, 
maximize, restore, or close your application. You access 
these icons with the mouse. 

Menu Bar 
The Menu Bar is located just below the Title Bar and 

contains the File, Edit, Scan, View, Tools, Advanced, 

Settings, Low Vision, Window, and Help Menus. 


To open these menus press ALT and the underlined letter, 
also referred to as the Access key. For example, press 
ALT+F to open the File menu. 
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Document Window 
The Document Window also referred as the Text View is the 
main area of the user interface, which remains blank until 
you open, scan, or type content into a new document. 
Depending on the amount of memory in your computer, you 
can have multiple document windows open at the same time. 
Each document can be in either Edit Mode or Read-only 
Mode. Similarly, you can scan multiple documents into 
OpenBook and view each document by pressing 
CTRL+TAB. 

Status Bar 
The Status Bar appears at the bottom of the document 
window. The left side displays the line the edit or reading 
cursor is on, the total number of lines in the document, the 
page number, and the total number of pages. For example, 
line 20 of 87, page 2 of 2. To read the Status Bar, press 
CTRL+SHIFT+F10. If you prefer not to view the Status Bar, 
press SHIFT+F5. This interface item is also accessible from 
the View Menu. 

Tip:	 If you want to hear the Title Bar and the Status Bar 
read, press SHIFT+F1. 

Scroll Bar 
The Scroll Bar is the shaded bar along the right side of the 
document window. It allows you to view other parts of a 
document. You scroll a document using the UP and DOWN 
ARROW keys or the PAGE UP and PAGE DOWN keys on 
your keyboard. 
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If you are a mouse user, left click your mouse on either the 
Scroll Up or Scroll Down Arrow. Or drag the box between the 
Scroll Arrows up or down by pressing and holding the left 
button on your mouse. 

Dialogs & Controls 
Dialogs are smaller windows that usually appear from a 
menu choice. They contain controls used to configure 
various settings. 

There are many types of controls in a dialog, such as edit 
fields, and combo boxes. 

In dialogs, TAB moves you forward through the controls, 
while SHIFT+TAB moves you backwards. 

Multi-Page Dialogs 
A Multi-Page dialog is a dialog with multiple pages. When 
you open a multi-page dialog, the name of the current page 
is announced after the name of the dialog. 

Multi-page dialogs contain an extra control, the page tab 
control. Move to this control the same as any other control, 
by pressing TAB or SHIFT+TAB until it is reached. Press 
RIGHT ARROW or LEFT ARROW to move between the 
pages of the dialog, and press TAB to move to the first 
control on that dialog page. 

You can also press CTRL+TAB to switch pages in a multi­
page dialog. 

Radio Buttons 
Radio buttons are small circles. Use DOWN ARROW to 
move through the radio buttons, and when you land on the 
appropriate choice, press TAB to move to the next control. 
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Note:	 Only one radio button in a group can be selected at a 
time. 

Edit Fields 
Edit fields are similar to the edit fields in word processors. 
You can type text into an edit field, and typically you can use 
the same navigation keystrokes here, as you would in a 
document edit field. A multi-line edit field allows you to type 
more than one line in an edit field. 

Edit Combo Box 
An edit combo box is a combination of two controls: an edit 
field and a list box. You can either type in a value or press 
ALT+DOWN ARROW to open a list box. The list contains 
suggestions for the contents of this field. Use the UP and 
DOWN ARROW keys to move through the list, and use 
ALT+UP ARROW or ESC to close the list box. If you do not 
find your choice in the list box, type it in the edit field. 

Combo Box 
A plain combo box differs from the edit combo box. You must 
make your selection from suggestions provided by the 
program. Either press DOWN ARROW to move through the 
choices, or press the first letter of the choice you want to 
make. 

Edit Spin Box 
The edit spin box is also a combination of two controls. You 
can type in this field, or use the arrow keys to move through 
the list of suggestions. Edit spin boxes are common for fields 
that require numeric values. 
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Check Box 
A check box can be checked or unchecked. OpenBook 
announces the current state of a check box when you move 
to it. Press SPACEBAR to check or clear a check box. 

Buttons 
Buttons are common to most dialogs. When you encounter a 
button, press the SPACEBAR to activate the button.   

Tree View 
In a tree view, items are presented in a hierarchical format, 
which is organized vertically on the screen. Press UP or 
DOWN ARROW to move through the tree view. When you 
hear, "closed…," you press RIGHT ARROW to open that 
level. You are then presented with more information beneath 
it. Press DOWN ARROW to move through the next level. 
One of those items may also be closed so you would press 
RIGHT ARROW again to open that item. If you want to close 
a level, press LEFT ARROW. To have an item display in the 
text view press ENTER on the standard keypad. 
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Book 4 
Adjusting Speech 

OpenBook allows you to adjust the speech settings so you 
can determine how much feedback you receive, which 
makes it easier to distinguish where and what OpenBook is 
reading. 

Selecting Voices 
With OpenBook, you can assign different voices for reading 
and editing text, speaking menu and dialog items, and for 
reading text that has emphasis such as underline, italic, or 
bold. Additionally, you can adjust the volume, pitch, and 
inflection of each voice. 

To select and adjust voices: 
1. 	Press ALT+G or click on the Settings Menu. 
2. 	Press P or select Speech Settings to open the Speech 

Settings Properties page. 
3. 	 When the Properties page opens the Voice Selection 

combo box is active. Use your UP or DOWN ARROW 
keys to select the voice you want to modify. 

Your choices are: 
•	 Reading Voice - the voice used to read and edit text. 
•	 Menu Voice - the voice used to read menus and 

dialogs. 
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•	 Emphasis Voice - the voice used to read text that is 
bold, underlined and in italics. The Emphasis Voice also 
reads bookmarks when the Announce Bookmarks is 
enabled in the General Settings Properties page. 

Note:	 In order to have OpenBook recognize text that is bold, 
underlined and in italics, you must enable Emphasis 
Text in the Scanning Settings Properties page. Please 
see the Book, Advanced Scanning, for more 
information. 

4. 	 Once you have selected a voice to modify, you can 
then press TAB to move to the Voice Name combo 
box. IBM’s ViaVoice TTS software used by OpenBook 
has five voice options for U.S. English: Shelley, Sandy, 
Reed, Grandpa, and Grandma. Use your UP or DOWN 
ARROW keys to make your selection. 

Note: 	 If you chose to use another speech synthesizer at 
installation, you may have a different number of voice 
options. 

5. 	 The next four controls are combo boxes that adjust the 
voice rate, volume, pitch, and inflection. You can 
experiment with these adjustments until you find the 
settings you like. Use your UP and DOWN ARROW 
keys to make your selections or point and click with 
your mouse. Press the TAB key to move to the next 
control or SHIFT+TAB to move to the previous control. 

To test the different voices options, press ALT+T. This 
activates the Test button, which also tests any voice 
modifications that you apply such as rate, volume, etc. To 
stop the test, press ALT+T again. 
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6. 	 Before you close this dialog you may want to globally 
apply your voice setting changes for one voice to the 
other voices. Press the TAB key until you hear, “Apply 
Settings to All Voices check box,” then press the 
SPACEBAR to check this box. 

7. 	 Last, if you want to make more setting changes, press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or, exit this properties page by pressing 
ENTER. 

Voice Punctuation 
To determine how much punctuation OpenBook announces 
while reading, choose an item from the Voice Punctuation 
combo box. Your choices are: 
•	 All - OpenBook speaks every period and comma. 
•	 Some - OpenBook speaks the less common 

punctuation but not periods and commas. This setting is 
the default. 

•	 None - OpenBook does not speak any punctuation. 

Note:	 The amount of punctuation you hear is unique to each 
synthesizer. 

To select Reading Voice Punctuation: 
1. 	Press ALT+G or click on the Settings Menu. 
2. 	Press P or select Speech Settings to open the Speech 

Settings Properties page. 
3. 	Press TAB until you hear, “Reading Voice Punctuation.” 
4. 	Use your UP and DOWN ARROW keys or point and 

click with your mouse to select your punctuation 
preference. 
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5. 	 Last, if you want to make more setting changes press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 

Language 
OpenBook supports 8 different languages. The Voice 
Language combo box lists the languages you chose during 
Custom Installation. Use your UP and DOWN ARROW keys 
or point and click with your mouse to select another 
language. If you did not install any other languages, this 
combo box is grayed out. 
1. 	Press ALT+G or click on the Settings Menu. 
2. 	Press P or select Speech Settings to open the Speech 

Settings Properties page. 
3. 	Press TAB until you hear, “Voice Language.” 
4. 	Use your UP and DOWN ARROW keys or point and 

click with your mouse to select a different language. 
5. 	 Last, if you want to make more setting changes press 

ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 

Note: 	 Some speech synthesizers allow you to select multiple 
as a choice in the Language combo box. Selecting 
multiple lets you choose any voice style from all of the 
languages available for the synthesizer. 
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Synthesizer 
The Synthesizer combo box lists the different speech 
synthesizers you can choose from. If you performed the 
typical installation, you can select either IBM ViaVoice TTS 
or RealSpeak. To add additional synthesizers to the list, run 
Setup.exe from the OpenBook CD. 

To change synthesizers: 
1. 	Press ALT+G or click on the Settings Menu. 
2. 	Press P or select Speech Settings to open the Speech 

Settings Properties page. 
3. 	Press TAB until you hear, “Synthesizer.” 
4. 	Use your UP and DOWN ARROW keys or point and 

click with your mouse to select a different synthesizer. 
5. 	 Last, if you want to make more setting changes press 

ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 

Note:	 With some speech synthesizers, inflection, punctuation, 
and multi-language options may not be available. 

Progress Messages 
This feature controls the messages that OpenBook speaks 
when it is scanning a page. When you start OpenBook this 
box is on by default. 

To uncheck Progress Messages: 
1. 	Press ALT+G or click on the Settings Menu. 
2. 	Press G or select General Settings to open the General 

Settings properties page. 
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3. 	Press TAB until you hear, “Progress Messages 
checkbox.” 

4. 	Press the SPACEBAR to uncheck the box. 
5. 	 Last, if you want to make more setting changes press 

ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 

Announce Shortcut and Access Keys 
Announces the menu shortcut or access keys (for example, 
CTRL+O for Open in the File Menu) after each menu item. 
This feature helps you learn these keystrokes so you can 
quickly perform the operations you want. When you install 
OpenBook this box is unchecked by default. 

To enable Announce Shortcut and Access Keys: 
1. 	Press ALT+G or click on the Settings Menu. 
2. 	Press G or select General Settings to open the General 

Settings properties page. 
3. 	Nest, press TAB until you hear, “Announce Shortcut 

and Access Keys checkbox.” 
4. 	Press the SPACEBAR to check the box. 
5. 	 Last, if you want to make more setting changes press 

ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 

Announce Dialog Controls 
If you want more feedback on the type of controls you 
encounter while working in OpenBook, then enable this item. 
OpenBook will announce whether an edit box, button, combo 
box, etc., is active. 
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1. 	Press ALT+G or click on the Settings Menu. 
2. 	Press G or select General Settings to open the General 

Settings properties page. 
3. 	Next, press TAB until you hear, “Announce Dialog 

Controls.” 
4. 	Press the SPACEBAR to check the box. 
5. 	 Last, if you want to make more setting changes press 

ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 

Announce Page Layout Elements 
Select this item to have OpenBook announce page elements 
while it reads a scanned document. To announce page 
elements, you must enable “Scan with Page Layout 
Elements” in the Scanning Settings Properties page. 

Examples of page elements are columns, headers, footers, 
and text blocks. The default setting for this item is checked. 

To enable Announce Page Layout Elements: 
1. 	Press ALT+G or click on the Settings Menu. 
2. 	Press G or select General Settings to open the General 

Settings properties page. 
3. 	Press TAB until you hear, “Announce Page Layout 

Elements.” 
4. 	Press the SPACEBAR to check the box. 
5. 	Next, TAB to the Apply button or press ALT+A, then 

press CTRL+TAB to move to the Scanning Settings 
properties page. 

28 



6. 	Press TAB until you hear, “Scan with Page Layout 
Elements.” 

7. 	Press the SPACEBAR to check the box. 
8. 	 Last, if you want to make more setting changes press 

ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 

Announce Headers and Footers 
Check this option if you want OpenBook to read the header 
and footer for each page when you use the Say All 
command (F10, F12, or NUM PAD ENTER). Uncheck this 
option if you do not want OpenBook to read headers and 
footers when you use the Say All command. You can still 
use the ARROW keys to read the header and footer. 

To enable Announce Headers and Footers: 
1. 	Press ALT+G or click on the Settings Menu. 
2. 	Press G or select General Settings to open the 

General Settings properties page. 
3. 	Press TAB until you hear, “Announce Headers and 

Footers.” 
4. 	Press the SPACEBAR to check the box. 
5. 	Activate the Apply button or press ALT+A. 
6. 	Press CTRL+TAB to move to the Scanning Settings 

properties page. 
7. 	Press TAB until you hear, “Scan with Page Layout 

Elements.” 
8. 	Press SPACEBAR to select the Scan with Page 

Layout check box. 
9. 	Press ENTER to activate the OK button. 
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Key Echo 
Use the Key Echo During Editing combo box to modify what 
echo you hear while you are editing a document. 
1. 	Press ALT+G or click on the Settings Menu. 
2. 	Press P or select Speech Settings to open the Speech 

Settings property page. 
3. 	Press TAB until you hear, “Key Echo During Editing” or 

press ALT+K to activate the combo box. Use the UP or 
DOWN ARROW keys to select the echo you want 
during editing. 

Your choices are: 
•	 Character - Speaks every keystroke as you type. 
•	 Word - Speaks only completed words; that is, it 

speaks the word you just typed as soon as you 
type punctuation or a space after it. 

•	 Both - Speaks both the keystrokes as you type 
and the final completed word after you type it. This 
is useful for beginning typists or with material you 
are proofreading. 

•	 Off - Does not echo any keystrokes. 
4. 	 Last, if you want to make more setting changes press 

ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 

Announce Capital Letters 
If you want OpenBook to announce capital letters while 
typing, you will then need to activate the Announce Capital 
Letters checkbox. 
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1. 	Press ALT+G or click on the Settings Menu. 
2. 	Press P or select Speech Settings to open the Speech 

Settings property page. 
3. 	Press TAB until you hear, “Announce Capital Letters 

While Typing” then press SPACEBAR or press ALT+C 
to place a check in the box. 

4. 	 Last, if you want to make more setting changes press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 

If you want to save your setting changes go back to the 
Settings Menu (ALT+G) and select Save the Settings (S). 
With the Save Settings dialog open, type a name for the new 
settings file, then TAB to the Save button and press ENTER. 
For more information, please see the book titled, Using 
Settings Files. 
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Book 5 
Adjusting Visual Settings 

Low Vision Menu 
Although, you can change the same settings in the Visual 
Settings Properties page, this menu provides an easy to use 
interface for adjusting some of the more common visual 
aspects of your document such as font size and type; text, 
cursor, and background colors; and character, word, and line 
spacing. 

The Low Vision Menu is available only if you are displaying 
your document in Text View. If you are displaying your 
document in Exact View, press CTRL+SHIFT+V to switch 
back to Text View. Press ALT+L or click Low Vision on the 
menu bar. Use the ARROW keys to navigate the menu 
items. When you find the item you want to change, press 
ENTER or click to select that item. This launches the Low 
Vision Settings dialog, which has six buttons and opens in 
the lower third of your screen. The button that corresponds 
with the item you selected in the Low Vision Menu will be 
active. At this time, you can press the SPACEBAR to 
change the setting, or press TAB to move to the next button. 

Note: All changes made from the Low Vision Menu are saved 
and are implemented the next time you open a 
document. 

If you want more control over each setting, press TAB to 
move to the Customize button and press ENTER. This 
opens the Visual Settings Properties page found under the 
Settings Menu. 
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For your convenience, there also are shortcut keys that 
control the features available in the Low Vision Menu. You 
can press these commands anytime you need to change the 
way text is displayed on your screen. These changes remain 
in effect until you exit OpenBook. Below lists the description 
of the shortcut keys. 

Font size -- increase CTRL+4 

Font size -- decrease CTRL+3 

Font & Background Color CTRL+5 

Font type CTRL+6 

Font spacing -- increase CTRL+8 

Font spacing -- decrease CTRL+7 

Visual Settings Properties page 
For complete control over how your document displays on 
your monitor go to the Visual Settings Properties page 
(ALT+G, V). From this page you can select your font type 
and size, page margins, and the color and spacing for every 
element on your page. Use Text View on the right to see 
how the changes you make affects the text. 

When this properties page opens the Font Name combo box 
is active. Use your UP or DOWN ARROW keys to select the 
font you want displayed. Press TAB to move to the next 
control. Again, use your UP or DOWN ARROW keys to 
make a selection. Follow these basic steps to make changes 
for the document displayed on your screen. When you are 
done, press ENTER to exit this properties page. 
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If you want to save your setting changes go back to the 
Settings Menu (ALT+G) and select Save the Settings (S). 
With the Save Settings dialog open, type a name for the new 
settings file, then TAB to the Save button and press ENTER. 
For more information, please see the book titled, Using 
Settings Files. 
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Book 6 
Using Settings Files 

Understanding Settings Files 
This book on Using Settings Files discusses the importance 
of Settings Files in their global application with OpenBook 
and explains how they are used. 

In the Settings Menu (ALT+G) there are three important 
items that make working with OpenBook convenient and 
easy, especially if you have multiple needs. These items are:  
• Save the Settings 
• Retrieve Settings 
• Delete Settings 

Save the Settings 
When launched, OpenBook always uses the Default Settings 
file. Therefore, whenever you go into the Settings Menu to 
change a setting you should save that change to the default 
settings file. Otherwise none of your changes will apply the 
next time you launch OpenBook. 

You can save multiple settings files to use for certain 
situations. For example, you may be required to use Arial 
font 14 point in your academic environment, but prefer to 
type your friend’s letter in Batang 16 point. Or, maybe you 
are studying or working in a programming language and 
need to scan documents using the Fine Reader OCR. 
Whatever your reasons are, here is how you save your 
settings so you can use them whenever you have to.  
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1. 	 Use the items in the Settings Menu (ALT+G) to make 
OpenBook work the way you want. 

2. 	 Go back to the Settings Menu (ALT+G) and select 
Save the Settings (S). 

3. 	 With the Save Settings dialog open, type a name for the 
new settings file or select the default file. 

4. 	 At this point, you can press TAB to move over to the 
Save button and press ENTER to save and exit the 
dialog or you can press TAB to move over to the list of 
radio buttons. 

5. 	 These radio buttons represent each of the menu items 
listed under the Settings Menu. Choose All Settings to 
incorporate all setting changes into one Settings File or 
create individual Settings Files for each settings 
change. 

6. 	Use your UP or DOWN ARROW key to select the item 
you want to save as a Settings File. You can make and 
apply as many Settings Files as you need. 

Retrieve Settings 
This item allows you to apply your Settings Files to your 
active document. If you choose not to retrieve any Settings 
Files, then OpenBook will use the default settings. 

To retrieve settings: 
1. 	 Go to the Settings Menu (ALT+G) and select Retrieve 

Settings (R). 
2. 	 Use your UP or DOWN ARROW key to move to the 

settings file you want to use. 
3. 	 Press ENTER to select the file and close the dialog. 
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4. 	 If you want to apply more than one Settings File, simply 
repeat the steps outlined above. 

Delete Settings 
1. 	 Go to the Settings Menu (ALT+G) and select Delete 

Settings (D). 
2. 	Use your UP or DOWN ARROW key to move to the 

settings file you want 
3. 	Press ENTER to delete the file 
4. 	 A second dialog appears and asks you to verify the 

deletion, press ENTER again and close the dialog. 
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Book 7 
Scanning 

Introduction to Scanning 
With OpenBook’s extensive scanning features, you can scan 
and have access to almost all printed documents. Unlike 
other scanning software, OpenBook processes the scanned 
image using optical character recognition (OCR) and 
converts the document into text. 

The Scan Menu, found on the menu bar, contains most of 
the controls you need to scan your items. 

The first item on the Scan Menu, Scan a Page, lets you scan 
the page you have placed on the scanner. There are three 
scanning keys, the INSERT key on the numeric NUM PAD, 
SPACEBAR and F4. When you scan multiple pages with 
this menu item, OpenBook inserts them at the end of your 
document, regardless of where your cursor is. 

Scanning a page: 
1. 	 Place the page to be scanned on the scanner first, then 

press F4. 
2. 	 During the scanning process, a dialog appears on your 

screen that indicates when the three scanning stages 
are complete. 
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Scan and Insert New Page 
Unlike the Scan and Replace Current Page menu item, Scan 
and Insert New Page does not remove pages, instead it 
inserts newly scanned pages before the current page on the 
screen. You find the Scan and Insert New Page menu item 
in the Scan Menu (ALT+S). Your UP or DOWN ARROW key 
moves to the item and ENTER selects it. 

2-page Scanning 
Select this menu item to scan two side-by-side pages of a 
book whose facing pages can both fit on the scanner glass. 
OpenBook will store the pages separately, with separate 
page numbers. This allows the page numbers in your 
document to match the page numbers in the scanned book. 
After scanning, OpenBook will automatically read the first 
page, and then read the second page. When you start 
OpenBook, this selection is not checked. To check this menu 
item, open the Scan menu (ALT+S), use the DOWN 
ARROW to select 2-page Scanning and press ENTER. 

Recognize Columns 
On by default, this feature is useful for scanning information 
that is in columns such as a newspaper. Turn this feature off 
when you scan information that needs to be read across a 
page such as a billing statement. To enable/disable this 
feature, press CTRL+SHIFT+Z or choose Recognize 
Columns from the Scan menu. 

Note: When tables are encountered with this control enabled, 
OpenBook moves across each row, from left to right, 
reading the content in each cell. 

To change the default setting for Recognize Columns: 
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1. 	Press ALT+G or click on the Settings Menu. 
2. 	Press C or select Scanning Settings to open the 

Scanning Settings property page. 
3. 	Press ALT+Z or click on Recognize Columns to 

uncheck the box. 
4. 	 To check the box, simply press ALT+Z or click on 

Recognize Columns. 
5. 	 If you want to make more setting changes, press 

ALT+A or TAB to the Apply button and press the 
SPACEBAR. 

6. 	 Exit this properties page by pressing ENTER. 
7. 	 Next, to change the settings so that Recognize 

Columns is always disabled, open the Settings Menu 
again (ALT+G). 

8. 	 From the Menu, choose Save the Settings... . 
9. 	 In the Save Settings dialog, press ENTER to make the 

changes part of the default settings. For more 
information on this feature, please see the book, Using 
Setting Files. 

BuckScan 
With American and Canadian paper currency, BuckScan 
recognizes denomination. In order for BuckScan to correctly 
recognize your currency, you must go to the Settings Menu 
and select General Settings (ALT+G, G), then press TAB 
until you hear Buckscan Currency combo box. From the 
combo box, use the UP or DOWN ARROW keys to select 
U.S. Dollars or Canadian Dollars. 
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To use BuckScan, place your bill horizontally along the edge 
of the glass plate’s right rear corner. Press CTRL+M or 
select BuckScan from the Scan menu. 

If OpenBook fails to recognize the denomination, try placing 
your bill horizontally along the edge of the glass plate’s left 
front corner. 

Color Scanning 
Scans pages of colored text, art, and photographs in color. 
When you start OpenBook, this feature is off by default. To 
check this menu item, open the Scan menu, use the DOWN 
ARROW to navigate to Color Scanning and press ENTER to 
select it. 

Additionally, the results of Color Scanning are only apparent 
while you are in Exact View (CTRL+SHIFT+V). For this 
reason you must have “Keep Exact View” enabled in the 
Scanning Properties page in order to use Color Scanning. 
Also, you can only do color scanning at 300 dpi resolution. 

If you do not have a color scanner installed, OpenBook will 
tell you that color scanning is not possible and will scan in 
black and white. 

Color scanning is a much slower process than the standard 
black-and-white scanning, so we recommend that you only 
use this item when you know you have something you want 
to save in its original color presentation. 

Selecting Color Scanning From the Scanning 
Properties page 
If you need to scan a document for its color properties, place 
a check in the Color Scanning checkbox. When checked, 
OpenBook allows for color scanning of text, art, and 
photographs. 

41 



To enable Color Scanning from the Scanning Properties 
page: 
1. 	Press ALT+G or click on the Settings Menu. Then 

press C or select Scanning Settings to open the 
Scanning Settings Properties page. 

2. 	Press ALT+I or click on Color Scanning to check the 
box. 

3. 	 To uncheck the box, simply press ALT+I or click on 
Color Scanning. 

4. 	 Last, if you want to make more setting changes, press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or, exit this properties page by pressing 
ENTER. 

Scan for Accuracy / Scan for Speed 
With OpenBook you have a choice of scanning for accuracy 
or scanning for speed. By default, scanning for accuracy is 
enabled so that the highest degree of accuracy, along with 
other special scanning features, are implemented. 

On the other hand, scanning for speed scans the document 
faster, but accuracy is lost. 

Only one of these features can be implemented at a time. To 
activate, open the Scan Menu (ALT+S), use the DOWN 
ARROW to select Scan for Accuracy/Scan for Speed and 
press ENTER. 
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Scan and Replace Current Page 
CTRL+SHIFT+F4 scans a page and replaces the current 
page with the newly scanned page. This feature is useful 
when you have a document with multiple pages and want to 
rescan and/or replace a page while maintaining the page 
sequence. 

Scan Preview 
Use Scan Preview (CTRL+NUM PAD 0) to quickly scan and 
read the first couple of lines in a document. If you then want 
to fully scan the page, press ESC, SPACEBAR. If you want 
to scan and preview another page, press CTRL+NUM PAD 
0 again. 

Photocopying Documents 
OpenBook allows you to scan a document or image and 
immediately send a copy of it to your printer. Perform the 
following to create a photocopy: 
1. 	Choose Photocopy from the Launch menu or press 

ALT+C, P. 
2. 	Press ALT+B and specify how many copies you want 

to make. Then press ALT+N and select the printer you 
want to use to create the copy. 

3. 	 If necessary, activate the Properties button or press 
ALT+P to change the paper size, orientation, and 
margins. 

4. 	Select the Fit Printed Page check box if you want 
OpenBook to resize the scanned image to take up all 
available space on the page. Clear this check box to 
print the image in its original size. 
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5. 	Use the UP and DOWN ARROW keys to adjust the 
brightness of the copy in the Brightness edit spin box. 
Positive brightness values produce lighter copies. 
Negative values produce darker copies. 

6. 	 Determine the color mode you want to use when 
scanning in the Color Mode combo box. Choose from 
colored, black and white (monochrome), or grayscale. 
You must have a color printer and scanner capable of 
scanning in color to create color photocopies. 

7. 	In the Resolution combo box, choose a scanning 
resolution. Higher resolutions result in more detailed 
images. 

8. 	Activate the OK button to begin scanning the image or 
document. When the scan is complete, OpenBook 
prints the copy using the designated printer. 

Scanning from Word 
You can a scan page with OpenBook while you are working 
in Microsoft Word. When OpenBook finishes scanning the 
page, it displays the text in Word. To scan a document from 
Word, do the following: 
1. 	 Place the page you want to scan on your scanner. 
2. 	 In Microsoft Word, open the File menu and choose 

Scan Using OpenBook. 

OpenBook scans the page. When OpenBook is finished 
scanning, it displays the text of the page in Word. 
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Book 8 
Reading 

Reading with OpenBook 
Whenever you open or scan a document, OpenBook 
immediately begins reading aloud, highlighting every word 
on the screen. This highlighting, referred to as the text 
spotlight, helps partially sighted users visually track cursor 
movement while OpenBook reads the text. 

This is just one of the many reading enhancements featured 
in OpenBook. When you start OpenBook, you are in Read­
only Mode. Press the NUM PAD ENTER or F12 key to 
toggle the read and pause feature. Use CTRL+1 to decrease 
the reading speed or increase the reading speed with 
CTRL+2. 

In this book we will discuss each reading feature and explain 
how you can optimize your reading experience. 

Movement Unit 
You can determine how much text is spotlighted by changing 
the movement unit. Your choices are word, sentence, line, or 
paragraph. 

To change the Movement Unit: 
1. 	Press ALT+G or click on the Settings Menu. 
2. 	Press G or select General Settings to open the General 

Settings Properties page. 
3. 	Press ALT+M or click in the Movement Unit combo 

box. 
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4. 	 When you choose the unit you want to read with, 
OpenBook displays the spotlight on the sample text at 
the right of the properties page. 

5. 	 Press the Ok button to exit this properties page. 

Fast Forward and Rewind 
With OpenBook, you can move quickly in a document using 
the Fast Forward or Rewind functions. To fast forward or 
rewind, you must be reading with the Say All command 
(NUM PAD ENTER, F10, or F12) or be skim reading using 
the SHIFT+F12 command. To fast forward, press the RIGHT 
SHIFT or the RIGHT ARROW key. To rewind, press the 
LEFT SHIFT or the LEFT ARROW key. Both sets of 
commands work equally well. However, if you use Windows 
Sticky Keys, then you should use the ARROW keys. 
Otherwise, you must uncheck the Disable Sticky Key Hotkey 
Toggle checkbox and check the Enable Shift Keys For Fast 
Forward and Rewind checkbox in the Keyboard Settings 
Properties page in order to use the SHIFT keys. 

To disable Sticky Keys and enable Shift keys for fast forward 
and rewind. 
1. 	Press ALT+G or click on the Settings Menu. 
2. 	Press K or select Keyboard Settings to open the 


Keyboard Settings property page. 

3. 	Next, press TAB until you hear, “Disable Sticky Key 

Hotkey Toggle checkbox.” 
4. 	Press the SPACEBAR to uncheck the box. 
5. 	Use the DOWN ARROW key to move to Enable Shift 

Keys For Fast Forward and Rewind checkbox. 
6. 	Press the SPACEBAR to check the box. 
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7. 	 Last, if you want to make more setting changes, press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or, exit this properties page by pressing 
ENTER. 

Skim Read 
If you need to quickly understand the main idea of a 
paragraph, you will find the Skim Read feature useful. Skim 
Read lets you read the first and/or last sentence of each 
paragraph in the document. To use the Skim Read feature 
you must be reading with Say All (F12), and press 
SHIFT+F12. To stop Skim Read, press any key. 

To change what is read when you use the Skim Read 

feature, follow these steps. 

1. 	Press ALT+G or click on the Settings Menu. 
2. 	Press P or select Speech Settings to open the Speech 

Settings property page. 
3. 	Next, press TAB until you hear, “Skim Read Speaks 

Paragraph combo box” or press ALT+M. 
4. 	Use the UP or DOWN ARROW keys to make your 

selection. 
5. 	 Last, if you want to make more setting changes, press 

ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or, exit this properties page by pressing 
ENTER. 
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Dictionary 
You can look up a word’s definition by selecting the word 
with either the mouse or the SHIFT+ARROW keys, then 
pressing CTRL+D or F8. When you select Dictionary, the 
Dictionary dialog opens, announces the selected word to be 
defined, and begins reading the definition. At this point, you 
have several controls from which to choose. Use the TAB 
key to navigate the dialog and press ENTER on the control 
that performs the particular action you want. 

Spell Word 
Press CTRL+L, CTRL+F3 if you want to spell the word that 
the cursor is on. When you select Spell Word, OpenBook 
speaks the word aloud, spells it letter by letter, and then 
speaks it aloud again. 

Spell Word Phonetically 
If you need to phonetically spell out a word, place your 
cursor on the word and press SHIFT+F3. For example, the 
word cab is spelled as Charlie, Alpha, Bravo, etc. 

Pronunciation Dictionary 
OpenBook's Pronunciation Dictionary can correct the 

pronunciation of a word or combination of letters. 


Using the Pronunciation Dictionary: 
1. 	 From the Advanced Menu, select Pronunciation 


Dictionary (ALT+T, N). 
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2. 	 When the Pronunciation Dictionary dialog opens, your 
cursor is in an edit field. Type the word that is mis­
pronounced. Do not use any spaces and/or punctuation 
as you type. 

3. 	Press TAB to move to the Pronunciation edit box. Type 
how the word is pronounced. Pronunciations can 
include spaces as this helps with stressing the correct 
syllable and with the pronunciation of vowels. 

4. 	Next, press ALT+L to move to the field containing the 
list of all the words in the pronunciation dictionary. 
Press the DOWN ARROW key or the first letter of the 
mispronounced word to move to the word in the list. 

5. 	 If the word is case sensitive, TAB to the Case Sensitive 
checkbox and press the SPACEBAR to place a check 
in the box. For example, you might want OpenBook to 
pronounce the text string "pa" as the word "pa" when 
the letters are not capitalized, but to say the individual 
letters, "P" "A", when they are capitalized. You would 
type the upper-case letters "PA" in the Word field, type 
the letters "P" and "A" (upper- or lower-case) in the 
Pronunciation field, and check the Case Sensitive box. 

6. 	Press ALT+T to hear the original word and the 
replacement word. You can use the Test button to test 
a word and its correction before you add it to the list. 

7. 	Press ALT+A to add the word and its pronunciation to 
the word list. 

8. 	Press ALT+D to delete a word and its pronunciation 
from the word list. 

9. 	Press ALT+P to have OpenBook apply the 
pronunciation to the open document. 

10. Press ALT+C to close the Pronunciation Dictionary 
dialog and return to your document. 
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Thesaurus 
You can look up a word's synonym or antonym by selecting 
a word with either the mouse or the SHIFT+ARROW keys, 
then pressing CTRL+T or SHIFT+F8. When you select 
Thesaurus, OpenBook opens the Thesaurus dialog, 
announces the selected word, lists the synonyms, and 
begins reading the list of synonyms in the Synonyms field. At 
this point, you have several controls from which to choose. 
Use the TAB key to navigate the dialog and press ENTER 
on the control that performs the particular action you want. 

Page Scrolling 
To control the upward movement of a page as the reading 
cursor reaches the bottom of the page, go to the View Menu 
(ALT+V), navigate the menu and press ENTER or click on 
Page Scrolling. Next, press ENTER on one of the three 
options: One line, 1/2 screen, or 3/4 screen. 

Extra Pause After Each Sentence 
If you need extra time to absorb the information that you are 
reading with OpenBook, then adding an extra pause after 
each sentence may be helpful. 

To adjust the time used in each pause, follow these steps. 
1. 	Press ALT+G or click on the Settings Menu. 
2. 	Press G or select General Settings to open the General 

Settings property page. 
3. 	Next, press TAB until you hear, “Extra Pause After 

Each Sentence combo box” or press ALT+X. 
4. 	Use the UP or DOWN ARROW keys to your selection. 
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5. 	 Last, if you want to make more setting changes, press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or, exit this properties page by pressing 
ENTER. 

Hide Spotlight for Braille Tracking 
For those who read using a refreshable Braille display, this 
item should be activated because the text spotlight 
decreases the responsiveness of refreshable Braille devices.  

To activate Hide Spotlight for Braille Tracking: 
1. 	Press ALT+G or click on the Settings Menu. 
2. 	Press G or select General Settings to open the General 

Settings property page. 
3. 	Next, press TAB until you hear, “Hide Spotlight for 

Braille Tracking checkbox” or press ALT+H. 
4. 	 If necessary, press the SPACEBAR to place a check in 

the box. 
5. 	 Last, if you want to make more setting changes, press 

ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or, exit this properties page by pressing 
ENTER. 
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Book 9 
Navigating Documents 

Bookmarks 
OpenBook allows you to insert an unlimited amount of 
bookmarks anywhere in a document. Serving as 
placeholders, bookmarks let you easily locate information 
previously viewed. When you use the Bookmark feature, 
OpenBook inserts a numbered bookmark at the current 
cursor position in the open document. Each bookmark is 
numbered and is linked to the word at its right. 

Bookmarks are announced with the Emphasis Voice. Please 
refer to Emphasis Voice in the Book, Adjusting the Speech. 

You add, rename, delete, or go to specific bookmarks from 
the Bookmarks dialog. 

When adding Bookmarks, first place your cursor in your 
document where you want to insert the bookmark. Then 
open the Bookmarks dialog by pressing F9 and TAB to the 
Add button. Press SPACEBAR to open the Add Bookmark 
dialog and type a name for your bookmark in the Bookmark 
Name edit box. Press ENTER to activate the Ok button and 
close the dialog. 

To rename a bookmark, open the Bookmarks dialog, use the 
UP or DOWN ARROW key to locate the bookmark in the list, 
and TAB to the Rename button. Press SPACEBAR to open 
the Rename Bookmark dialog and type a new name for your 
bookmark in the Bookmark Name edit box. Press ENTER to 
activate the Ok button and close the dialog. 
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To delete a bookmark, open the Bookmark dialog, use the 
UP or DOWN ARROW key to locate the bookmark in the list, 
and TAB to the Delete button. Press SPACEBAR to open 
the Delete Bookmark dialog. When asked to confirm the 
deletion, press ENTER to activate the Yes button or press 
TAB, then ENTER to activate the No button. 

Tip: Rather than use the delete button in the Bookmark 
dialog, it is easier to place your cursor to the right of the 
Bookmark and press the BACKSPACE key or 
CTRL+SHIFT+F9. 

To go to a specific bookmark, open the Bookmarks dialog, 
use the UP or DOWN ARROW key to locate the bookmark 
in the list, and press ENTER to activate the Go To button. 

You may also change how your bookmarks are sorted. To 
do this, press the TAB key until you hear Sort by Name radio 
button. Next, use your UP or DOWN ARROW key to make 
your selection. Your choices are Sort by Name or Sort by 
Location. 

To have OpenBook announce each Bookmark while it is 
reading the document, you must go to the General Settings 
Properties page and place a check in the Announce 
Bookmarks checkbox. 
1. 	Press ALT+G or click on the Settings Menu. 
2. 	Press G or select General Settings to open the General 

Settings properties page. 
3. 	Press TAB until you hear, “Announce Bookmarks 

checkbox.” 
4. 	Press the SPACEBAR to check the box. 
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5. 	 Last, if you want to make more setting changes, press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or, exit this properties page by pressing 
ENTER. 

Find 
The Find feature is a very handy tool that lets you search for 
a word or phrase within an open document quickly. When 
you press CTRL+F, OpenBook launches the Find dialog with 
the cursor in the Find What edit box. Type in the word or 
phrase you want to find. Use the TAB key to navigate the 
dialog. Other controls in this dialog that are available are 
Find Whole Words Only, Match Case, and Search Direction. 

When you are ready, press ENTER on the Find Next button. 
When OpenBook has found the word or phrase, press 
ENTER on the Read Sentence button. This reads the 
sentence that contains the words you are seeking.  

Find and Replace Text 
The Find, Replace menu item (CTRL+H) is similar to the 
Find feature in that it searches for words or phrases within a 
document, but it has the additional feature of replacing words 
or phrases with alternative text. Its dialog is similar to the 
Find dialog but has two additional buttons. The Replace 
button, which replaces one instance of the word or phrase 
and the Replace All button, which replaces all instances of 
the word or phrase in the document. 
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Go To Page 
When you want to go to a specific page in the open 
document, press CTRL+G to open the Go To Page dialog. 
Type the number of the page you want. Press ENTER and 
OpenBook takes you to the top of the page whose number 
you have specified. If the document does not contain the 
requested page, OpenBook takes you to the nearest page, 
which will be the first or last page in the document. 
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Book 10 
Page Layout 

OpenBook provides you with the ability to hear as well as 
see how a page is laid out. This is useful because 
information about the structure of a document helps you 
understand how each element relates to one another. Page 
elements are headers, footers, columns, headings, text 
blocks, tables, and pictures. To use any of the page layout 
features, you must scan with the page layout elements 
control enabled. 

To enable Scan with Page Layout Elements: 
1. 	Press ALT+G or click on the Settings Menu. 
2. 	Press C or select Scanning Settings to open the 

Scanning Settings Properties page. 
3. 	Press TAB until you hear Scan with Page Layout 

Elements then press SPACEBAR to place a check in 
the box. 

4. 	 Press the Ok button to save your changes and exit this 
properties page. 

The page layout features are: Start Page Description, 
Guided Page Layout Mode, Explore Page Layout Mode, 
Announce Page Layout Elements, and Move to 
Next/Previous Element. 

Note:	 For instructions on using Announce Page Layout 
Elements, please see the Book, Adjusting Speech. 

To hear a description of what page elements are used in a 
document, press CTRL+SHIFT+Y or ALT+T, T. 
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If you want to hear and see how a page is laid out and what 
page elements are used, you should choose either Guided 
Page Layout Mode or Explore Page Layout Mode. Both 
modes, available in Exact View and in Text View, are 
essentially the same in that they both use the mouse to 
spotlight an element while OpenBook describes that element 
to you. The main difference between each mode is that 
Guided Mode automatically moves your mouse about the 
page, while Explore Mode lets you to move your mouse to 
“explore” the page. 

To use Guided Page Layout Mode, press CTRL+SHIFT+F5 
or go to the Tools Menu (ALT+T) and press G. 

For Explore Page Layout Mode, the command is 
CTRL+SHIFT+ENTER or ALT+T, X. 

To move to the next or previous page layout element in the 
document, press CTRL+SHIFT+DOWN ARROW or UP 
ARROW. OpenBook announces the type of element you 
have moved to. You can use the following keystrokes to 
specify that you want to move through only elements of a 
certain type when using this command: 
• CTRL+SHIFT+A - All page layout elements 
• CTRL+SHIFT+D - Headers 
• CTRL+SHIFT+C - Columns 
• CTRL+SHIFT+H - Section headings 
• CTRL+SHIFT+B - Text blocks 
• CTRL+SHIFT+P - Pictures 
• CTRL+SHIFT+N - Captions 
• CTRL+SHIFT+T - Tables 
• CTRL+SHIFT+O - Footers 
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Book 11 
Editing 

When you start OpenBook, you are in Read-only Mode by 
default. All of OpenBook’s editing features are only available 
in Edit Mode. To switch to Edit Mode press CTRL+E or if you 
prefer, change the default setting so that OpenBook always 
starts in Edit Mode. In Edit Mode you still retain all of your 
scanning features. 

To always start in Edit Mode: 
1. 	Press ALT+G or click on the Settings Menu. 
2. 	Press G or select General Settings to open the General 

Settings property page. 
3. 	Press ALT+E or click on Always Start In Edit Mode to 

place a check in the box. 
4. 	Press ENTER or click OK to apply your changes and 

close this dialog. 
5. 	 Open the Settings Menu again (ALT+G) and choose 

Save the Settings (S). 
6. 	 In the Save Settings dialog, press ENTER to make the 

changes part of the default settings. For more 
information on this feature, please see the book, Using 
Setting Files. 

Note:	 Edit Mode is only available with Text View selected. To 
switch to Text View, press CTRL+SHIFT+V. 
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Basic Editing Commands 
Although OpenBook is primarily a scanning and reading 
software, it does include most of the commonly used editing 
features associated with other popular word processing 
software. You can find many of these features in the Edit 
Menu. 

Undo 
The Undo feature (CTRL+Z) is very handy for undoing the 
last command you performed. Unlike many word processing 
applications, this feature only reverts one command at a 
time. 

Cut 
To cut selected text from a document and copy it to the 
OpenBook clipboard, press CTRL+X. To select text, hold the 
SHIFT key down while pressing the ARROW keys, or use 
the mouse to highlight the text. 

Copy 
Copying selected text places it on the clipboard without 
removing it from the document. Once you have selected the 
text you want to copy, press CTRL+C. You can then paste 
the text into another part of the open document, into a new 
OpenBook document, or into another application such as 
Microsoft Word. 

Paste 
Choose Paste when you want to insert text from the 
Microsoft Windows clipboard into your document. Find the 
location where you want the text inserted, then press 
CTRL+V. The text is then inserted into the document. 
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Delete 
Unlike cutting selected text from a document, deleting does 
not copy the text to the Microsoft Windows clipboard. Once 
you use the DEL key, the selected text is permanently 
deleted and cannot be pasted. Press CTRL+Z to undo the 
delete. 

Select All on Current Page 
This item selects all text in Read-only Mode and in Edit 

Mode. The shortcut key for Select All is CTRL+A. 


Renumber Pages 
This feature allows you to change the page numbers of an 
open document, as well as, maintain the original page 
numbering in a scanned document. 

To renumber pages: 
1. 	 From the Edit Menu, select Renumber Pages or press 

ALT+E, A. 
2. 	 OpenBook brings up the Renumber Pages dialog and 

places your cursor in an edit field. 
3. 	 OpenBook prompts you with the current page number 

and asks you for the new number you want to assign to 
that page. Type in a number, then press ENTER, or 
TAB to the Ok button. 

4. 	 You can cancel the operation at any time by going to 
the Cancel button or by pressing the ESC key. 
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Be sure to give each succeeding page a new number larger 
than the page numbers before it. For example, you could 
have a 3-page document that you renumber as pages 10, 
20, and 30, but you can't renumber the pages as 20, 30, and 
10. If you type in a number that breaks this rule, OpenBook 
will prompt you to enter a valid number. 

You can revert back to OpenBook's original page numbering 
sequence at any time by checking the box called Revert to 
original page numbers. Press the SPACEBAR to put a 
check in this box, then press ENTER. 

Insert Page Break 
When you need to insert a page break in your document, 
place your cursor on the line where you want the break to 
occur then press CTRL+ENTER. OpenBook inserts a page 
break immediately before the current line of the document. 
The text after the inserted page break becomes the 
beginning of the new page; the text before the inserted page 
break becomes the end of the previous page. 

Delete Page Break 
To use this feature, move your cursor to the bottom of the 
first of the two pages. Go to the Edit Menu (ALT+E). Use 
your UP or DOWN ARROW keys to move to the Delete 
Page Break menu item and press ENTER. Or you can 
simply press CTRL+SHIFT+DELETE from within the 
document. 

Move Page 
When you need to move the current page to another location 
in a document select Move Page from the Edit Menu. 

To move a page: 

61 



1. 	Press ALT+E, M to select the Move Page item. 
2. 	 In the Move Page dialog, use the TAB key to move 

about the different controls in the dialog. 
3. 	 On the button controls press ENTER. 
4. 	 In the edit box, type the page number that you want to 

move the current page to. Or, type +2 or –2 to move 
forward or back 2 pages. Once OpenBook moves the 
page, it tells you the current page's new page number 
and the other pages in the document are renumbered 
to accommodate the moved page. 

Delete Current Page 
Select this menu item to delete the page your cursor is on. 
When you delete the current page, OpenBook opens a 
dialog warning you that page deletion cannot be undone, 
and asks you to confirm the deletion. CTRL+DELETE 

Strip Headers and Footers 
Sometimes, it maybe helpful to remove the header and/or 
footers from your scanned documents especially when you 
are reading. 

Before you can apply this feature you must first scan your 
document with Scan with Page Layout Elements enabled. 

To enable Scan with Page Layout Elements: 
1. 	Press ALT+G or click on the Settings Menu. Then 


press C or select Scanning Settings to open the 

Scanning Settings Properties page. 


2. 	 Select the Scan with Page Layout-Elements check box. 
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3. 	 When you enable this item, a dialog displays telling you 
that Keep Exact View is automatically enabled as well. 
Press ENTER to close this dialog. 

4. 	Press SPACEBAR on the OK button to apply your 

settings and close the OpenBook Settings dialog. 


5. 	 Now you are ready to scan your document. Press 

SPACEBAR or F4. 


After you scan a document with page layout elements, you 
can then strip the headers and footers. From the Edit 
Menu (ALT+E), choose Strip Headers/Footers. Choose 
whether to remove the header, footer, or both by 
selecting the appropriate check boxes. Press ENTER to 
remove the headers/footers from the Text View and 
close the dialog. This does not remove the 
headers/footers from the Exact View image. 

Spell Check 
You can check the spelling of a specific word, or of all the 
words in a document. If a word is spelled correctly, but not 
recognized, you can add the word(s) to OpenBook’s 
dictionary. In order for Spell Check to work you must be in 
Text View (CTRL+SHIFT+V). To check the spelling in a 
document, press CTRL+K or F7. OpenBook verifies the 
spelling of each word by comparing them to its dictionary. 

Once the spell check is done, a dialog opens and words that 
are not recognized or are identified as misspelled appear in 
the Word Not Found box. At this point, you have several 
options to choose from. Use the TAB key to navigate the 
dialog and press ENTER on the control that performs the 
particular action you want. When you encounter a combo 
box, use the UP or DOWN ARROW keys to make your 
selection. 

63 



Word Count 
Press SHIFT+F7 when you want to know the number of 
words in a document. 

OCR Correction 
Use the OCR Correction feature to correct any words that 
OpenBook's OCR engine does not correctly identify. 

To use OCR Correction follow, these steps: 
1. 	Press ALT+A, O to launch the OCR Correction dialog. 
2. 	 When the OCR Correction dialog opens the Word list 

box is active. Type the first letter of the mis-identified 
word then use your UP and DOWN ARROW keys to 
find the word. 

3. 	 If the word is not found in the list, press the TAB key to 
move to the mis-identified word edit box and type in the 
word as it appears in the document. OpenBook's OCR 
Correction feature only recognizes for whole words and 
punctuation. Do not use spaces. 

4. 	Press TAB to move to the next edit box. In this field 
enter the word the way OpenBook should have 
recognized it. Corrections can include spaces. 

5. 	 If the OCR correction is case sensitive, TAB to the 
Case Sensitive checkbox and press the SPACEBAR to 
place a check in the box. 

6. 	Press ALT+T to hear the original word and the 
replacement word. You can use the Test button to test 
a word and its correction before you add it to the list 
and for word already in the list. 

7. 	Press ALT+A to add the word and its correction to the 
word list. 
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8. 	Press ALT+D to delete a word and its correction from 
the word list. 

9. 	Press ALT+P to have OpenBook apply corrections from 
its list to the open document. 

10. Press ALT+C to close the OCR Correction dialog and 
return to your document. 

You can have OCR corrections applied to every document 
that you scan. Go to the Scanning Settings Properties page 
(ALT+G, C), press ALT+O to place a check in this box. Use 
the TAB key to move to the Apply button and press 
SPACEBAR. Last, press ENTER to close this page. 
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Book 12 
Managing Files 

Most of the routine tasks of managing and maintaining your 
document files can be accessed directly from the File Menu 
(ALT+F). 

If you sign in as an individual user, OpenBook uses 
C:\OpenBk7\Users\default\Library as the default file location. 

If you have signed in using the Multi-user feature, OpenBook 
creates an individual subfolder in your name. In this case, 
the location that your files are saved in is: 
C:\OpenBk7\Users\username\Library. 

If it is more convenient for you to save or open your files in a 
location other than the Library, follow these steps: 
1. 	Press ALT+G or click on the Settings Menu. 
2. 	Press G or select General Settings to open the General 

Settings properties page. 
3. 	Press ALT+C or click on Default File Location to place 

your cursor in the edit box. 
4. 	 Type the new default location. 
5. 	 Last, if you want to make more setting changes press 

ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or, exit this properties page by pressing 
ENTER. 
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OpenBook has its own file format called ark, which is the 
default file format whenever you open or save a file. If you 
want a different file format set as the default file type, you 
must change the setting in the General Settings properties 
page. 

To change the default file format setting: 
1. 	Press ALT+G or click on the Settings Menu. 
2. 	Press G or select General Settings to open the General 

Settings properties page. 
3. 	Press TAB until you hear Default File Format or press 

ALT+F to activate the combo box. Use the UP or 
DOWN ARROW keys to select the file type you want 
set as the default. 

4. 	 Last, if you want to make more setting changes press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or, exit this properties page by pressing 
ENTER. 

Basic File Operations 
Creating a New File 

Select this menu item to create a new file. When you select 
New, OpenBook creates a new untitled document file. The 
shortcut key for this item is CTRL+N. 

Opening a File 
When you select Open, OpenBook opens a dialog called, 
“Select a File to Open.” The dialog contains a list of available 
files. Use TAB and SHIFT+TAB to move from field to field, 
and the UP and DOWN ARROWS to move from item to item 
within a field. When you locate the file you want to open, 
press ENTER. 
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To open a file: 
1. 	Press CTRL+O to open the Select a File to Open 

dialog. 
2. 	 When the “Select a File to Open” dialog opens, the File 

Name edit box is active. Press TAB to move to the 
Files of Type combo box and use the ARROW keys to 
select the format of the file you want to open. 

3. 	Next, press SHIFT+TAB twice to move to the files List 
View. 

4. 	Use the UP or DOWN ARROW key to navigate the List 
View to find the file or folder you want to open. When 
you have found it, press ENTER. 

5. 	 If you cannot find the file or folder in the List View, you 
may want to look in the Tree View. Press SHIFT+TAB 
to move to the Look in combo box. 

6. 	Use your UP ARROW key to navigate the Tree View. 
As you move to each folder, it opens automatically 
revealing its contents in the List View below. 

7. 	 After you have selected the file format, found the folder, 
and selected the file you want to open, press TAB to 
move to the Open button and press ENTER. 

Recently Opened Files 
OpenBook lists the last five files you have opened on the 
File menu. To access a recently opened file, press ALT+F to 
display the File menu and then press a number between 1 
and 5 on the numbers row. Pressing 1 opens the most 
recent file, pressing 2 opens the second most recent file, and 
so on. Use the ARROW KEYS to move through the menu if 
you want to hear the names of each recently opened file. 

68 



Opening Files with the Freedom Import Printer 
The Freedom Import Printer allows you to import graphics 
based text into OpenBook. Once imported, you can read the 
text with the same keystrokes used with other scanned text. 
If you set OpenBook so that Keep Exact View is enabled 
(ALT+G, C, ALT+V), you can then view the pages in their 
original form. 

Note: Importing an unsupported file format will only work if 
you have the associated application installed on your 
computer. 

There are two methods that you can use to open 
unrecognized files. 

The first method is to open the file (CTRL+O) within 
OpenBook. 

Note: Be sure to select the file format you are trying to open 
from the Files of Type combo box. This allows you to 
view the file in the file/folder list view. 

OpenBook will launch the associated application, which in 
turn sends an image of the file to OpenBook’s OCR where it 
is recognized and displayed as text. Once the text is 
displayed in OpenBook, the associated application will close. 
If you want to keep the exact image, you must enable the 
Keep Exact View checkbox in the Scanning Settings 
Properties page. 
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The second method is to open the file with its associated 
application and depending on the application, select either 
the Print, Print Setup, or Print Properties dialog. In the printer 
name combo box, choose Freedom’s Import Printer as your 
printer. Press the Print button. If OpenBook is running, the 
text of the file will display in OpenBook. If OpenBook is not 
running, pressing the print button will launch OpenBook 
displaying a new document with its text. 

Closing a File 
When you close a document, OpenBook prompts you to 
save the document if you have made editorial changes. The 
shortcut keys for this item are CTRL+W or CTRL+F4. 

Saving a File 
This menu item saves the current document in the default 
location or in the folder from which you opened the 
document. The shortcut key is CTRL+S. 

Save As 
This menu item allows you to save the current document 
under a new name, in a different file format, and in a different 
folder. Other supported file formats include Word, WordPro, 
WordPerfect, and HTML. 

To Save As: 
1. 	Press ALT+F to open the File Menu. 
2. 	Use your UP or DOWN ARROW key to navigate to 

Save As and press ENTER to open the Save As dialog. 
3. 	 When the Save As dialog opens, the File Name edit 

box is active. So if you want to name or rename your 
file, just type in the new name. 
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4. 	 If you want to save the file in a different folder, press 
SHIFT+TAB to move to the files List View. 

5. 	Use the UP or DOWN ARROW key to navigate the List 
View and press ENTER when you find the folder where 
you want to save the file. 

6. 	 If you cannot find the file or folder in the List View, you 
may want to look in the Tree View. Press SHIFT+TAB 
to move to the Look in combo box. 

7. 	Use your UP ARROW key to navigate the Tree View. 
As you move to each folder, it opens automatically 
revealing its contents in the List View below. 

8. 	Press TAB to move to the Files of Type combo box and 
use the ARROW keys to select the file format you want 
to save. 

9. 	 After you have named your file, found the folder, and 
selected the file format you want to save to, press TAB 
to move to the Ok button and press ENTER. 

Creating a New Folder 
Since the Open, Save As, Save Pages, and Save to Audio 
items have the same dialog features, you can create a new 
folder anytime you select these items. 

To create a new folder: 
1. 	Press ALT+F to open the File Menu. 
2. 	Use your UP or DOWN ARROW key to navigate to any 

of the following items: Open, Save As, Save Pages, 
and Save to Audio. 

3. 	 When the dialog opens, press ALT+F to activate the 
New Folder button. 

4. 	 A new folder is created in the List View of the dialog. 
Type the name of the new folder. 
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5. 	Press ENTER twice to open the new folder. 

Save Pages 
CTRL+SHIFT+S is the command that allows you to save 
either the current page or a range of pages in the open 
document. This item is useful when you scan pages of mail 
or other items to selectively save only the pages you want to 
keep. You can save just the page your cursor is on, or you 
can specify a range of pages to save. 

To save pages: 
1. 	 From the File Menu, choose Save Pages (ALT+F, then 

G). 
2. 	 The Save Pages dialog opens with Save Current Page 

radio button checked. If you want to save only the 
current page, press ENTER. OpenBook takes you to 
the File Open dialog and prompts you for a file name. 

3. 	 If you want to save a range of pages, press the DOWN 
ARROW once to check the Save Page Range radio 
button and activate the edit box. Type in the range of 
pages you want to save, for example, 2-6 or 2,3,4. 
Once you have entered a valid range, press ENTER or 
press TAB to go to the Ok button, then press ENTER. 
OpenBook will take you to the File Open dialog and 
prompt you for a file name. You can cancel the 
operation at any time by going to the CANCEL button 
or pressing ESC. 

Note:	 If you have used the Renumber Pages function to 
change the number sequence in your document, you 
must specify the revised page numbers in the Save 
Pages dialog. 
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Saving to Audio 
If you own an audio player that will play .wav or mp3 files 
you will want to use this feature. Save to Audio converts 
OpenBook supported files into .wav or .mp3 file formats. 

Note 1:	 If you are using RealSpeak as the reading voice 
synthesizer, the audio file that you create may not 
sound the same as it did when you read the file in 
OpenBook. The Save to Audio feature is not currently 
configured to use RealSpeak.  OpenBook will use 
ViaVoice instead. 

Note 2:	 Using an external synthesizer such as DECtalk Express 
or DoubleTalk to save an audio file, may result in 
unpredictable speech output through the sound card 
and speakers. 

To save to audio: 
1. 	 Open or scan the file you want to save as audio. 
2. 	Press ALT+F to open the File Menu. 
3. 	Use your UP or DOWN ARROW key to navigate to 

Save to Audio and press ENTER to open Save Pages 
dialog. 

4. 	 If you just want to save the current page, press the TAB 
key to move to the Ok button and press ENTER. 

5. 	 If the document you opened is large and you are saving 
a range of pages, use your DOWN ARROW key to 
select Save Page Range. 

6. 	Press TAB to move to the Page Range edit box and 
type in the page numbers. You can use dashes or 
commas between each number. 

73 



7. 	 If you want to save the entire audio file as one file, 
press the TAB key to move to the Save Range as a 
Single File checkbox and press SPACEBAR to place a 
check in this box. Leaving this box unchecked saves 
each page as a separate file. 

8. 	Press the TAB key to move to the Ok button and press 
ENTER. 

9. 	 When the Save to Audio dialog opens, the File Name 
edit box is active. Type a name for the file in this edit 
box. 

10. Press TAB to move to the Files of Type combo box and 
use ARROW keys to select the file format. 

11. 	 If you want to save the file in a different folder, press 
SHIFT+TAB twice to move to the files List View. 

12. Use the UP or DOWN ARROW key to navigate the List 
View and when you find the folder where you want to 
save the file, press ENTER. 

13. 	 If you cannot find the file or folder in the List View, you 
may want to look in the Tree View. Press SHIFT+TAB 
again to move to the Look in combo box. 

14. Use your UP ARROW key to navigate the Tree View. 
As you move to each folder, it opens automatically 
revealing its contents in the List View below. 

15. 	 When you have found the folder where you want to 
save the file, press TAB to move to the Save button 
and press ENTER to begin the text to audio conversion. 
This may take a few minutes depending on the size of 
the file. To cancel the process, press ENTER again. 
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Note: If you attempt to save an audio file with the same name 
as an existing file, OpenBook adds 01 to the end of the 
filename. OpenBook does not overwrite the existing file. 

Document Properties 
Select this item to view specific information about the open 
document. CTRL+R 

Recently Opened Files 
This convenient Windows feature lists recently opened files 
(numbered 1 through 5) so you can easily access the files 
you worked with last. To open the file you want either select 
the file and press ENTER, or press the number and then 
ENTER. 

Importing and Exporting Braille Files 
When exporting files to .brf or .brl format OpenBook 
translates in grade 2 Braille using the same page and line 
break as in the original file. By default, there are 25 lines per 
page and 40 cells per line. Braille files (.brf, .brl) are imported 
as text files. 

Currently, emphasized text (bold, italic, underline) is not 
imported into text files, but is maintained when exporting .brf 
or .brl files. 

To import or export Braille files, press ALT+F, B. This opens 
the Braille submenu, which has two options: Import a Braille 
File to Text Format and Export the Current File to Braille 
Format. 

To access files on your notetaker, please see the Book, 
Using Your Notetaker. 
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Using the Library 
The Library is an easy to use system for storing your 
documents. It uses the metaphor of documents and 
categories rather than the Windows® files and folders 
metaphor. It is easy to use because it accesses a document 
management system within OpenBook that has several 
predefined categories in which you can store your 
documents. So if you are not yet comfortable with the 
Windows environment, we recommend you use the friendly 
environment of the OpenBook Library. To access the 
Library, press ALT+F, L.

 Library submenu: 
Read a Document - This option allows you to open a 
document for reading. 

Create a New Document - This option allows you to create 
a new document, save it to a library category, and then scan 
pages into it. 

Close Document - This option allows you to close the 
document you are currently reading. If you have made 
changes, you will be prompted to save your document. 

Save Document - This option allows you to save the 
document you are currently reading without closing it. 

Convert Document – Select Convert Document when you 
want to convert an OpenBook document format into a word 
processing, an ASCII, a spreadsheet, or an HTML format. 

Delete a Document - This option allows you to delete a 
document. 
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Create a New Category - This option allows you to create 
and name new categories. 

Delete a Category - This option allows you to remove 
categories that are obsolete. However, you will not be able to 
delete a category until you have deleted all documents inside 
that category. OpenBook will ask you to verify your deletion. 

Read a File – Select this option when you want to open and 
read a word processing, ASCII, or spreadsheet file. Once 
you select Read a File, you enter the standard Windows® 
environment. This environment allows access to all available 
files on your hard drive. To open a file to read, please refer 
to the topic, Opening a File, found in this book, Managing 
Files. 
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Book 13 
Low Vision Features 

Masking 
Available in Read-only Mode with Text View, Masking 
emphasizes the text you are reading by shading the text you 
are not reading. With Masking, you have four options: Line 
Masking, Sentence Masking, Paragraph Masking, and No 
Masking. 

To use Masking: 
1. 	Press ALT+G or click on the Settings Menu. 
2. 	Press M or select Masking Settings to open the 

Masking Settings Properties page. 
3. 	Press TAB to move to the Masking Increments. Use the 

UP or DOWN ARROW key to select one of the four 
options: No Masking, Sentence, Line, and Paragraph. 

4. 	 If you selected Sentence, Line, or Paragraph, press 
TAB to move to the Text Slider control. Use the 
ARROW keys to lighten or darken the text on the page. 

5. 	Press TAB again to move to the Background Slider 
control. Use the ARROW keys to lighten or darken the 
background color on the page. 

6. 	 Last, if you want to make more setting changes press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 
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Show Exact View 
Pressing CTRL+SHIFT+V toggles between the default Text 
View and the Exact View. Exact View is the scanned page 
displayed exactly as the original document. In this view, you 
can: read the page, change background and text colors, use 
the dictionary and spelling tools, control the zoom feature, 
and use the Text Window. Show Exact View is only available 
for scanned documents and if you have activated Keep 
Exact View in the Scanning Settings properties page of the 
Settings menu. 

To enable Keep Exact View: 
1. 	Press ALT+G or click on the Settings Menu. 
2. 	Press C or select Scanning Settings to open the 

Scanning Settings property page. 
3. 	Press ALT+V or click on Keep Exact View to place a 

check in the box. 
4. 	 Press Ok button to exit this properties page. 

To change background and text colors, you must go to the 
Visual Settings Properties page in the Settings Menu. 

Text Window 
In Exact View you can open a Text Window that displays the 
spotlighted text. This feature is very handy for brochures, 
flyers, etc. where pictures and text tell the story, but word 
recognition is difficult for the reader. You can change the font 
size, type, character spacing, and color of the text. You can 
also change the background color of the Text Window. 

To change Text Window elements: 
1. 	Press ALT+G or click on the Settings Menu. 
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2. 	Press V or select Visual Settings to open the Visual 
Settings property page. 

3. 	Press TAB or click on any of the controls and make the 
changes necessary for reading. 

4. 	 Press the Ok button to exit this properties page. 

Zoom Exact View 
You can change the zoom of a scanned page displayed by 
selecting one of the ranges on the Zoom Submenu. The 
ranges are from 25% of normal size to 800% of normal size. 
To use this feature you must display the document in Exact 
View. You find the Zoom Exact View in the View Menu 
(ALT+V). 

Delete Exact View 
Since Exact View makes your files bigger, you may want to 
save hard disk space by deleting the Exact View of the file 
after you are done using it. 

From the Edit Menu, select Delete Exact View (ALT+E, X). 
OpenBook asks you to confirm the deletion as this command 
deletes the Exact View from all pages in the open document, 
not just the current page. 
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Book 14 
Printing 

The option to print your files is important to your productivity. 
Regardless of your task, having your information in hard 
copy allows for easy access and reference. 

There are two ways to launch the print dialog. The easy way 
is to press CTRL+P from within any document. The other 
way is to open the File Menu (ALT+F) and select Print (P). 
Unless you want to change print parameters or you have 
more than one printer installed on your computer, you can 
immediately press ENTER or select the Ok button to print a 
single copy of your document. 

Number of Copies 
Unless you specify the number of copies printed, OpenBook 
will only print one copy of a document. 

To print more than one copy of a document: 
1. 	Press CTRL+P to open the Print dialog. 
2. 	Press TAB until you hear “Number of copies one.” 
3. 	Use your UP or DOWN ARROW keys to increase or 

decrease the number of copies to be printed. 
4. 	 Once you have selected your number, you can change 

more print parameters or press TAB to move to the Ok 
button, then press ENTER to print your document. 
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Selecting a Print Range 
The Print Range area of the Print dialog is composed of 
three radio buttons: All Pages, Selected Text Only, and 
Pages from:_ to:_. Unless you specify a print range, 
OpenBook will print all pages contained with in a document. 

To specify a Print Range: 
1. 	Press CTRL+P to open the Print dialog. 
2. 	Press TAB until you hear “All Pages checked.” 
3. 	Use your UP or DOWN ARROW keys to make your 

selection. If you choose Pages from:_ to:_, be sure to 
TAB to the Edit boxes and type in a number. 

4. 	 Once you have selected your new page range, you can 
change more print parameters or press TAB to move to 
the Ok button, then press ENTER to print your 
document. 

Changing Print Font 
In the Print dialog there is a Print Font area, which has two 
radio buttons: Print using default font, and Print as displayed. 
When installed OpenBook’s default font is Arial 14 point. 

To change the print font from default to as displayed: 
1. 	Press CTRL+P to open the Print dialog. 
2. 	Press TAB until you hear “Print using default font.” 
3. 	Use your UP or DOWN ARROW keys to move between 

each radio button. 
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4. 	 Once you have selected how you want your document 
to print, you can change more print parameters or press 
TAB to move to the Ok button, then press ENTER to 
print your document. 

To change the default print font: 
1. 	Press ALT+G or click on the Settings Menu. 
2. 	Press G or select General Settings to open the General 

Settings Properties page. 
3. 	Press TAB until you hear, “Default Print Font Name.” 
4. 	Use your UP or DOWN ARROW keys to select your 

new default printer font. 
5. 	Press TAB to move to the Default Print Font Size 

combo box. 
6. 	Use your UP or DOWN ARROW keys to select your 

new default font size. 
7. 	 Last, if you want to make more setting changes, press 

ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 

To change the display font: 
1. 	Press ALT+G or click on the Settings Menu. 
2. 	Press V or select Visual Settings to open the Visual 

Settings Properties page. 
3. 	Press TAB or click on any of the controls and make the 

changes necessary to the display font. 
4. 	 Press the Ok button to exit this properties page. 
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Changing Printers 
If multiple printers are installed on your computer, then 
OpenBook uses the same default printer designated in 
Windows. 

While OpenBook’s Print dialog allows you to change printers, 
it does not allow you to change the default printer. 

To change printers: 
1. 	Press CTRL+P to open the Print dialog. 
2. 	Press ALT+N to move to the Name combo box. This 

edit box lets you select a different printer. Use your UP 
or DOWN ARROW keys to select another printer. 

3. 	Press ENTER or select the Ok button to print your 
document. 

Page Orientation 
The Orientation area of the Print Setup dialog is composed 
of two radio buttons: Portrait and Landscape. 

To change the page orientation: 
1. 	Press CTRL+P to open the Print dialog. 
2. 	Use TAB to move to the Properties button and press 

SPACEBAR to open the Print Setup dialog. 
3. 	Next, press TAB until you hear “Page Orientation.” Use 

your UP or DOWN ARROW keys to make your 
selection. 

4. 	 Once you have selected the page orientation, you can 
change more print parameters or press ENTER to 
return to the Print dialog. 
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5. 	 To print your document, press TAB to move to the Ok 
button, then press ENTER to start the print job. 

Choosing Paper Size 
The default paper size setting for OpenBook is 8.5 x 11 
inches. 

To choose another paper size: 
1. 	Press CTRL+P to open the Print dialog. 
2. 	Use TAB to move to the Properties button and press 

SPACEBAR to open the Print Setup dialog. 
3. 	 When this dialog opens, your cursor is in the Paper 

Size edit box. This edit box lets you select a different 
paper size. Use your UP or DOWN ARROW keys to 
make your selection. 

4. 	 Once you have selected your new page size you can 
change more print parameters or press ENTER to 
return to the Print dialog. 

5. 	 To print your document, press TAB to move to the Ok 
button, then press ENTER to start your print job. 

Selecting a Paper Source 
If your printer has more than one paper tray or a manual 
feed, use this combo box to select the tray you want your 
printer to use when you print your document. 

To select a paper source: 
1. 	Press CTRL+P to open the Print dialog. 
2. 	Use TAB to move to the Properties button and press 

SPACEBAR to open the Print Setup dialog. 
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3. 	Next, press TAB until you hear “Paper Source.” Use 
your UP or DOWN ARROW keys to make your 
selection. 

4. 	 Once you have selected the paper source, you can 
change more print parameters or press ENTER to 
return to the Print dialog. 

5. 	 To print your document, press TAB to move to the Ok 
button, then press ENTER to start your print job. 

Setting Page Margins 
Page margins can only be set using inches. When you install 
OpenBook, the default margin set for the top, bottom, left, 
and right page edge is 1 inch. 

To set page margins: 
1. 	Press CTRL+P to open the Print dialog. 
2. 	Use TAB to move to the Properties button and press 

SPACEBAR to open the Print Setup dialog. 
3. 	Next, press TAB until you hear “Left Margin.” In the edit 

box, type in the number you want to set for the left 
margin. 

4. 	Press TAB to move to the Right Margin edit box and 
type the number you want set for the right margin. 
Repeat this step if you want to set the top and bottom 
margins. 

5. 	 Once the margins are set, you can change more print 
parameters or press ENTER to return to the Print 
dialog. 

6. 	 To print your document, press TAB to move to the Ok 
button and press ENTER to start the print job. 
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Book 15 
Faxing 

OpenBook allows you to send and receive faxes just like a 
stand-alone fax machine. You can send either exact copies 
of documents, or OpenBook can recognize the text and send 
text-only versions of documents. To send a fax, choose Fax 
from the Launch menu. To enable OpenBook to receive 
faxes, or to establish your fax preferences, choose Fax 
Settings from the Settings menu. 

Sending Faxes 
OpenBook allows you to fax your documents to anyone with 
a fax machine or computer capable of receiving faxes. 
Perform the following to send a fax: 
1. 	Choose Fax from the Launch menu, or press ALT+C, 

F 
2. 	 To send a saved OpenBook document as a fax, choose 

Create Fax or press C. 

OR 

To send the currently active OpenBook document as a 
fax, choose Send Current Document or press D. 

3. 	 Enter the name of the person you want the send the fax 
to in the Send To edit box. If you have already sent a 
fax to this person, type all or part of the name and press 
ALT+K. Use the ARROW keys to select the 
appropriate person and then press ENTER. OpenBook 
inserts the fax number and cover page information you 
used for the last fax you sent this person. 
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4. 	 Enter the recipient’s fax number in the Fax Number 
edit box. 

5. 	 To include a cover page with your fax, select the 
Include Cover Page check box. The cover sheet 
includes recipient information (name, title, company, 
etc.), sender information (name, company, etc.), the 
subject of the fax, and any additional comments. 

6. 	 If you include a cover page, enter the title and company 
of the recipient. 

7. 	 If you include a cover page, enter a descriptive title for 
the fax in the Subject edit box. 

8. 	 Enter any additional comments you want to make 
concerning the document in the Comments area. This 
information prints out on a separate cover page when 
the fax is received. 

9. 	 If you want to scan a new document and add it to the 
document you intend to fax, insert a page into your 
scanner and activate either the Scan Only or Scan and 
Recognize button. Activating the Scan Only button 
allows you to send the exact view of the document, 
including all original images, page layout elements, 
fonts, styles, and formatting. If you activate the Scan 
and Recognize button, OpenBook creates a text-only 
version of the document with no images or special 
formatting. This allows you to send just the text of the 
document as a fax. 

10. 	 If you want to add an existing OpenBook document to 
the fax, activate the Add Document button. Select a 
saved document. OpenBook adds the new content to 
the end of the active document. 
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11. 	 Once you are satisfied with the content of the fax, 
activate the Send Fax Now button. OpenBook dials the 
number you specified in the Recipient Fax Number 
edit box and attempts to send the fax. You can click the 
Abort Fax Call button to hang up during a call. 

Fax Settings 
Choose Fax Settings from the Settings menu or press 
ALT+G, F to set up your fax preferences. 

Sender Information 
Enter the name, company name, fax number, and telephone 
number you want listed whenever you send a fax. This 
information will be printed on your cover pages if you choose 
to include one in a fax. 

If you must dial a special prefix to reach a local outside 
number, enter that prefix in the Local Dialing Prefix edit 
box. For example, many office phone systems require you to 
dial ‘9’ before you dial an outside number. 

Redialing Options 
In the Number of Retries edit spin box, enter the number of 
times OpenBook should retry a number that has failed to 
answer. The maximum number of retries you can specify is 
20. After OpenBook tries to re-send the fax the specified 
number of times without success, a dialog box displays 
allowing you to cancel the fax or continue trying to send the 
fax. 

In the Time Between Redials box, specify the amount of 
time OpenBook should wait before redialing a number after a 
failed attempt. This time is measured in seconds. 
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Receive Faxes 
Select the 	Receive Faxes check box if you want your PC to 
answer calls and receive faxes in OpenBook. Specify how 
many times you want to allow calls to ring before OpenBook 
answers in the Rings to Answer box. 

Note: 	 OpenBook will only answer calls made to the phone line 
connected to your PC. 

Advanced Fax Settings 
Activate the Advanced button or press ALT+D to specify a 
communications port, fax class, reset string, and initialization 
string to use when sending faxes in OpenBook. 

Activate the OK button to save your settings, or activate the 
Cancel button to return to the Fax Settings dialog box 
without saving your changes. 

Receiving Faxes 
OpenBook can also receive faxes sent to the phone line 
connected to your computer. Perform the following to set up 
OpenBook to receive faxes: 
1. 	Choose Fax Settings from the Settings menu, or 

press ALT+G, F to set up your fax preferences. 
2. 	 To begin receiving faxes, select the Receive Faxes 

check box. 
3. 	Press ALT+W and specify how many times you want to 

allow calls to ring before OpenBook answers them in 
the Rings to Answer edit box. 
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4. 	Activate the OK button to save your preferences. 
OpenBook now answers all calls dialed into your PC 
after the specified number of rings. 

After you receive a fax transmission, OpenBook asks if you 
want to open the fax. If you choose to open the fax, the file is 
automatically converted into OpenBook format. If you choose 
not to open the fax, the Save As dialog box displays, 
allowing you to save the fax image file. 
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Book 16 
Embossing 

Before you can emboss a document, you must first select 
your embosser type in the Properties dialog, which is 
accessed from the Emboss dialog (ALT+F, E). 

Setting Up Your Embosser 
When you select your embosser, many of the fields in the 
Properties dialog automatically populate with your 
embosser’s default settings. This means you can 
immediately begin embossing your document or you can 
change the embossing settings. 
1. 	Press ALT+F, E to open the Emboss dialog. 
2. 	Use TAB to move to the Properties button and press 

SPACEBAR to open the dialog. 
3. 	 When this dialog opens, your cursor is in the Embosser 

combo box. This combo box lists embossers that are 
compatible with OpenBook. Use your UP or DOWN 
ARROW keys to select your embosser. 

4. 	Press TAB until you hear, “Connection combo box.” 
5. 	Use your UP or DOWN ARROW keys to select the port 

connecting your embosser. 
6. 	 If you select Windows Device, press TAB to move to 

the Windows Device combo box. This combo box lists 
all the printers and embossers available to your 
computer. 

7. 	Use your UP or DOWN ARROW keys to select an 
embosser. 
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8. 	Press ENTER or select the Ok button to return to the 
Emboss dialog. 

Embossing a Document 
Embossing a document is initiated from the Emboss dialog. 
To launch the Emboss dialog you must open the File Menu 
(ALT+F) and select Emboss (E). With the Emboss dialog 
open, you have several controls that allow you to change the 
way your document is embossed. If you do not want to 
change any of the parameters and are ready to emboss, 
press TAB until you reach the Ok button and then press 
ENTER. 

Number of Copies 
Unless you specify the number of copies printed, OpenBook 
will only print one copy of a document. 

To print more than one copy of a document: 
1. 	Press CTRL+P to open the Print dialog. 
2. 	Press TAB until you hear “Number of copies one.” 
3. 	Use your UP or DOWN ARROW keys to increase or 

decrease the number of copies to be printed. 
4. 	 Once you have selected your number, you can change 

more emboss parameters or press TAB to move to the 
Ok button. Press ENTER to print your document. 

Changing Emboss Settings 
Depending on your needs, you may want to emboss on 
different size paper. Changes made to the embossing 
settings are retained until you change them or reset them to 
their defaults. 

For 8.5 x 11 inch paper, use the following settings: 
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Cell Per Line: 34 
Lines Per Page: 25 
Top Margin in lines: 0 
Max Cells Per Line of Embosser: 34 
Max Lines Per Page of Embosser: 27 

For 11.5 x 11 inch paper, use the following settings: 

Cell Per Line: 40 
Lines Per Page: 25 
Top Margin in lines: 0 
Max Cells Per Line of Embosser: 42 
Max Lines Per Page of Embosser: 27 

To change embossing settings: 
1. 	Press ALT+F, E to open the Emboss dialog. 
2. 	Use TAB to move to the Properties button and press 

SPACEBAR to open the dialog. 
3. 	Press TAB to move to the Set Cell Per Line To edit 

box. Type the number of Braille cells you want in each 
line. 

4. 	Press TAB to move to the Set Lines Per Page To edit 
box. Type the number of lines you want on each page. 

5. 	Press TAB to move to the Set Top Margin in lines to 
edit box. Type the number of lines you want to set for 
your top margin. 

6. 	Press TAB until you hear, “Max Cells Per Line of 
Embosser edit box.” Type the absolute maximum 
number of cells you want on each line. 

7. 	Press TAB to move to the Max Lines Per Page of 
Embosser edit box. Type the absolute maximum 
number of lines you want on each page. 
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8. 	Press ENTER or select the Ok button to print your 
document. 

To reset your embosser’s default settings: 
1. 	Press ALT+F, E to open the Emboss dialog. 
2. 	Use TAB to move to the Properties button and press 

SPACEBAR to open the dialog. 
3. 	 When this dialog opens, your cursor is in the Embosser 

combo box. Use your UP or DOWN ARROW keys to 
select another embosser. 

4. 	 Reselect your embosser. The default settings will 
repopulate each field. 

5. 	Press ENTER or select the Ok button to return to the 
Emboss dialog. 

Computer Braille vs. Grade 2 Braille 
By default, OpenBook will send text to your embosser in 
Grade II Braille. However it can be set to emboss in 
computer Braille if necessary. 

To change between computer Braille and Grade II Braille: 
1. 	Press ALT+F, E to open the Emboss dialog. 
2. 	Press TAB until you hear, “Grade 2 checked.” 
3. 	 A check in this box means the document will emboss in 

Grade 2 Braille. To emboss in computer Braille, press 
SPACEBAR to uncheck this box. 

4. 	 Once you have selected the Braille language, you can 
change more emboss parameters or press TAB to 
move to the Ok button and then press ENTER to 
emboss your document. 
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Selecting an Emboss Range 
The Emboss Range area of the Emboss dialog is composed 
of 2 radio buttons: All Pages and Pages from:_ to:_. Unless 
you specify a range, OpenBook will emboss all pages 
contained within a document. 

To specify an Emboss Range: 
1. 	Press ALT+F, E to open the Emboss dialog. 
2. 	Press TAB until you hear “All Pages checked.” 
3. 	Use your UP or DOWN ARROW keys to make your 

selection. If you choose Pages from:_ to:_, be sure to 
TAB to the Edit boxes and type in a number. 

4. 	 Once you have selected your new page range, you can 
change more emboss parameters or press TAB to 
move to the Ok button and then press ENTER to 
emboss your document. 

Mark Emphasis Text 
Emphasis text is text that is bold, underlined and/or in italics. 
This item (enabled by default and only available when 
embossing in Grade 2 Braille) indicates when text has 
emphasis. 

Note:	 In order for this item to work properly, you must enable 
Emphasis Text in the Scanning Settings Properties 
page. 

To disable Mark Emphasis Text: 
1. 	Press ALT+F, E to open the Emboss dialog. 
2. 	Press TAB until you hear, “Mark Emphasis Text.” 
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3. 	 A check in this box means bold, underline and/or italic 
text is marked. 

4. 	 If you want to emboss without marking Emphasis Text, 
press SPACEBAR to uncheck this box. 

5. 	 To emboss your document, press TAB to move to the 
Ok button and then press ENTER. 

97 



Book 17 
Book Search 

Quick Book Search 
OpenBook helps you quickly search a variety of sources for 
books in electronic format. Use the Book Search feature to 
download your favorite books from the Baen Free Library, 
Bookshare.org, and Project Gutenberg. 

To search for a book: 
1. 	From the Launch menu, choose Book Search. Select 

Quick Search… from the submenu. Alternatively, you 
can press ALT+C, B, Q. 

2. 	 Enter the title and/or author of the book you are 
searching for. 

3. 	Press ALT+S. Choose the online book providers you 
want to include in the search by selecting the 
corresponding check boxes. Clear the check boxes 
next to the providers you do not want to include in the 
search. 

Note: 	 In order to download copyrighted books from 
BookShare.org, you must establish a Bookshare.org 
user account. If you have an account, press ALT+L to 
select the Login to Bookshare.org check box. When 
you begin the book search, OpenBook will ask you to 
enter the e-mail address and password for your 
Bookshare.org account. If you do not select the Login 
to Bookshare.org check box, OpenBook will only 
search Bookshare.org for books that are not 
copyrighted. 
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4. 	Activate the Begin Search button or press ALT+B to 
search for books. OpenBook displays a list of books 
that match your criteria. 

Note: 	 If you cannot find the book(s) you want to download, 
you can revise your search. Activate the Revise 
Search button (or press ALT+R) and then enter a 
different title and/or author. 

5. 	 When the search is complete, use the UP and DOWN 
ARROW keys to scroll through the list. Press 
SPACEBAR to select the check boxes next to the 
books you want to download. 

6. 	Activate the Download button or press ALT+D to begin 
downloading the books. The file(s) are saved in the 
Books folder of your Library. 

7. 	 When the download is complete, activate the Open 
Files Now button to view your downloaded books. 
Activate the Done button to view the file(s) at a later 
time. 

Advanced Book Search 
The Advanced Book Search feature provides you with 
additional search options. 

To perform an advanced search: 
1. 	From the Launch menu, choose Book Search. Select 

Advanced Search… from the submenu. Alternatively, 
you can press ALT+C, B, A. 

Note: 	 You can also activate the Advanced Search button in 
any dialog box. 

2. 	 Enter keywords to search for in the Contains edit box. 
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3. 	In the Search combo box, choose whether to search for 
these keywords in the titles or author names. Repeat 
this process for the second edit box. 

4. 	 Choose one of the following options: 

•	 Ignore – Ignore books with titles or authors 
containing the keyword specified in the second edit 
box. 

•	 And – Search for all keywords you enter in both edit 
boxes. 

•	 Or – Search for books with titles or authors 
containing keywords in either the first edit box OR 
the second edit box. 

5. 	Press ALT+S. Choose the online book providers you 
want to include in the search by selecting the 
corresponding check boxes. Clear the check boxes 
next to the providers you do not want to include in the 
search. 

Note: 	 In order to download copyrighted books from 
BookShare.org, you must establish a Bookshare.org 
user account. If you have an account, press ALT+L to 
select the Login to Bookshare.org check box. When 
you begin the book search, OpenBook will ask you to 
enter the e-mail address and password for your 
Bookshare.org account. If you do not select the Login 
to Bookshare.org check box, OpenBook will only 
search Bookshare.org for books that are not 
copyrighted. 
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Activate the Begin Search button or press ALT+B to search 
for books. Choose and download books just as you would 
during a Quick Search. 
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Book 18 
Using Your Notetaker 

Supported Notetakers 
You can access your notetaker files using OpenBook as the 
interface. Currently, Braille Lite, Type Lite, Braille ‘n Speak, 
Type ‘n Speak, Braille Note, and Voice Note notetakers are 
supported. You can also use your PAC Mate with 
OpenBook. 

Preparing Your Notetaker 
If you are using your notetaker as a Braille display with a 
screen reader, you will need to disable your Braille display 
settings in both your notetaker and screen reader before 
transferring any files. 

Freedom Scientific Notetakers 
First, you must connect your notetaker to your computer with 
the serial cable supplied. Next, press O-CHORD, W-CHORD 
(DOTS 1-3-5 CHORD, DOTS 2-4-5-6 CHORD) to prepare 
your notetaker to communicate with your PC. 

Freedom Scientific's PAC Mate 
Freedom Scientific's PAC Mate with Pocket PC uses 
ActiveSync to communicate with OpenBook. To move files 
between OpenBook and your PAC Mate, perform the 
following: 
1. 	 Ensure that ActiveSync is installed on your computer. 

ActiveSync is included on your PAC Mate Companion 
CD. 
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2. 	 Connect your PAC Mate to your computer using the 
supplied USB cable. 

3. 	ActiveSync detects the connection and starts 
automatically. If you have not already done so, you 
must establish a partnership between ActiveSync and 
your PAC Mate. 

Note: 	 If ActiveSync does not automatically detect the PAC 
Mate, start ActiveSync on your computer. Open the File 
menu and choose Get Connected. 

4. 	 OpenBook and PAC Mate are now ready to exchange 
files. 

Pulse Data HumanWare Products 
Pulse Data/HumanWare Notetakers use Microsoft 

ActiveSync to communicate with a PC. 

1. 	 Connect your notetaker to your computer using the 

serial cable supplied. 
2. 	 Launch ActiveSync from your computer. 
3. 	 On your BrailleNote, press U (DOTS 1-3-6) to open the 

Utilities Menu. 
4. 	 From the ActiveSync File Menu (ALT+F), select Get 

Connected (G). 
5. 	 Then on your notetaker press C (DOTS 1-4) to connect 

to ActiveSync. 
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Setting Up OpenBook 
Before using OpenBook with your notetaker, you must first 
define your notetaker communication parameters with 
OpenBook. 
1. 	 From the File Menu (ALT+F) select Notetaker (T). This 

opens the Notetaker submenu, which has two items: 
Open from and Save to. 

2. 	Use your UP or DOWN ARROW key to select a menu 
item, then press ENTER. 

3. 	 This launches the “Setup your Notetaker dialog.” 
4. 	 With the Notetaker combo box active, use your UP or 

DOWN ARROW key to select your notetaker. 
5. 	Then press ENTER on the Setup your Notetaker dialog 

to complete the connection. 

If you own a Pulse Data HumanWare Product, be sure to 
complete the steps outlined above. 

Using Auto-Detect 
If you own a Freedom Scientific Product, you can use the 
Auto-Detect Freedom Scientific Notetaker button (ALT+A). 
This button automatically detects your notetaker type and 
communication parameters. 

Manually Setting Up OpenBook 
Or if you prefer, follow the rest of these steps to manually set 
up your communication parameters. 
1. 	Press TAB to move to the Connection combo box. 
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2. 	Use your UP or DOWN ARROW key to select the Com 
Port to which your notetaker is connected to your 
computer. 

3. 	Press TAB to move to the Baud Rate control. Select 
the baud rate that matches the one set on your 
notetaker. 

4. 	Press TAB again to move to the Always Prompt for 
Notetaker check box. Place a check in this box if you 
use more than one notetaker with OpenBook. 

Note:	 Any communication parameter changes that need to be 
made should be done from the Notetaker Properties 
page, which is accessed from the Settings Menu. 

5. 	Press ENTER to activate the Ok button. 

Changing Settings 
1. 	Press ALT+G or click on the Settings Menu. 
2. 	Press N or select Notetaker Settings to open the 

Notetaker Settings Properties page. 
3. 	 With the Notetaker combo box active, use your UP or 

DOWN ARROW key to select your notetaker. 
4. 	Press TAB to move to the Connection combo box and 

select the Com Port to which your notetaker is 
connected to your computer. 

5. 	Press TAB to move to the Baud Rate control. Select 
the baud rate that matches the one set on your 
notetaker. 

6. 	Press TAB again to move to the Always Prompt for 
Notetaker check box. Place a check in this box if you 
use more than one notetaker with OpenBook. 

7. 	Press TAB to move to the Apply button, then press 
SPACEBAR to activate the button. 
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8. 	Press ENTER to activate the Ok button. This exits the 
properties page. 

Opening Files 
To open files from your notetaker: 
1. 	 From the File Menu (ALT+F) select Notetaker (T). This 

opens the Notetaker submenu, which has two items: 
Open from and Save to. 

2. 	Use your UP or DOWN ARROW key to select, Open 
from, then press ENTER. 

3. 	 From the Select a file to open dialog, press 

SHIFT+TAB to move into the files list. 


4. 	Use your UP or DOWN ARROW key to select a file, 
then press ENTER. 

Saving Files 
To save files to your notetaker: 
1. 	 From the File Menu (ALT+F) select Notetaker (T). This 

opens the Notetaker submenu, which has two items: 
Open from and Save to. 

2. 	Use your UP or DOWN ARROW key to select, Save to, 
then press ENTER. 

3. 	 Type a name for the file you want to save. 
4. 	Press SHIFT+TAB to move into the files list. 
1. 	Use your UP or DOWN ARROW key to select a folder 

in which you want to save your file, then press ENTER. 
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Book 20 
Launchable Applications 

Launchable Applications are word processing or Braille 
transcription applications that you can start from OpenBook’s 
Launch Menu. When you start an application from the 
Launch Menu, the new application becomes active while 
OpenBook runs in the background. Documents, originally 
opened in OpenBook, open in the file format of the new 
application. 

Note:	 You may need screen-reading software to read 
documents in some of these launchable applications. 

To move between applications, hold down the ALT key, and 
press the TAB key. You may need to press TAB more than 
once to cycle through each application. When you reach the 
application you want active, release both keys 
simultaneously. 

Adding New Launchable Applications 
During installation, you determine which launchable 
applications you want to use. To add new launchable 
applications to OpenBook: 
1. 	From the Launch menu, choose Manage 

Launchables. Select Add… from the sub-menu. 
Alternatively, you can press ALT+C, M, A. 

2. 	 OpenBook displays the Add Launch Application dialog 
box. 

3. 	In the Menu Name edit box, enter the name of the 
launchable application. This is the name that will 
appear on the Launch menu. 

107 



4. 	In the Program Path edit box, enter the location and 
name of the file used to start the application. 

If you do not know the location and/or name of the file, 
press ALT+B to activate the Browse for Program 
button. Locate the file that starts the application and 
select it. Press ENTER to insert the location and name 
of the file into the Program Name edit box. 

If you know the name of the file, but not the location, 
press ALT+S to activate the Automatic Search for 
Program button. Enter the name of the file and press 
ENTER to activate the OK button. OpenBook locates 
the file and inserts the full path and file name into the 
Program Name edit box. 

5. 	 If you want to apply parameters to the command line 
enter any command line arguments in the Command 
Line Argument edit box. 

6. 	 If you want to minimize the application after it is started, 
press ALT+N and select the Minimize on Launch 
check box. 

7. 	 If you want OpenBook to export the active document to 
the application when you launch it, press ALT+X to 
select the Export Document check box. Press TAB 
and enter the folder location where you want OpenBook 
to save the exported document in the Export 
Document To edit box. 

Note: 	 If you do not know the exact path of the export folder, 
press TAB and then press SPACEBAR on the Browse 
for Folder button. This allows you to browse for the 
folder you want to export documents to. 
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8. 	 If you want to convert the active OpenBook document 
into a file format used by the launchable application, 
make a selection in the Save as Type combo box. Use 
the UP and DOWN ARROW keys to select the format 
you want to use when converting documents for this 
launchable application. 

9. 	Activate the Add button or press ALT+A to add the 
application to the Launch menu. 

Editing Launchable Applications 
To edit the menu name, command line parameters, 
conversion settings, and other options for a launchable 
application: 
1. 	From the Launch menu, choose Manage 

Launchables. Select Edit… from the sub-menu. 
Alternatively, you can press ALT+C, M, E. 

2. 	 OpenBook displays the Launch Programs dialog box, 
which contains a list of all launchable applications.  

3. 	Use the UP and DOWN ARROW keys to select the 
launchable application you want to edit. Then press 
TAB and activate the Edit button. 

4. 	 OpenBook displays the current information and settings 
for the application in the Edit Launch Program dialog 
box. This dialog box is identical to the Add Launch 
Application dialog box. 

5. 	 Modify the settings for the launchable application. Refer 
to “Adding Launchable Applications” for more 
information on the options available in this dialog box. 

6. 	 When you have finished, activate the Update button or 
press ALT+U to save your changes. 
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Deleting Launchable Applications 
To remove an application from the Launch menu: 
1. 	From the Launch menu, choose Manage 

Applications. Select Delete… from the sub-menu. 
Alternatively, you can press ALT+C, M, D. 

2. 	 OpenBook displays the Launch Programs dialog box, 
which contains a list of all launchable applications.  

3. 	Use the UP and DOWN ARROW keys to select the 
launchable application you want to remove. Then press 
ENTER to activate the Delete button. 

4. 	Activate the Yes button or press ALT+Y to confirm that 
you want to remove the application from the Launch 
menu. 

OpenBook confirms that the application has been removed. 
Press ENTER to activate the OK button. 
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Book 21 
Advanced Scanning 

Scanner Selection 
You can specify the type of scanner driver you want 
OpenBook to use. The number of driver choices depends on 
the number of scanners installed on your system. OpenBook 
detects each scanner driver installed on your computer and 
automatically selects a default driver. If there are no drivers 
installed, OpenBook displays a dialog asking you to confirm 
the scanner driver selection. 

Note: Due to its slow speed, we do not recommend using the 
HP TWAIN driver unless you are using one of the HP 
3200-4300 series scanners. 

To change scanner drivers: 
1. 	Press ALT+A to open the Advanced Menu. 
2. 	Use the UP or DOWN ARROW key to navigate to 

Scanner Selection and press ENTER on the item. 
3. 	 With the Scanner Selection dialog open, press the TAB 

key until you hear, “Scanner combo box.” 
4. 	 In the combo box, use the UP or DOWN ARROW key 

to select the scanner type you are using. 
5. 	 If you found your scanner among those listed in the 

combo box, press TAB, then ENTER to close this 
dialog. 
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If you did not find your scanner among those listed, then 
select “Unknown Twain Using:” as your scanner. When you 
select this option you may need to manually fine-tune the 
scanner’s twain properties so that it will work with 
OpenBook. 

For instance, if you canceled a scan in the middle of the 
process and you are no longer able to scan. Place a check 
in the Allow scanner to finish when canceling a scan 
checkbox. 

When a scanned document with Color disabled and Keep 
Exact View enabled looks identical to a scanned document 
using a contrast setting of 255. Place a check in the Black 
and white contrast uses Brightness instead of Threshold 
checkbox. This should darken the contrast for better 
visibility. 

If your first scan works, but subsequent scans seem to 
ignore any changes made in the Scanner Settings Properties 
page, you need to place a check in the Must close TWAIN 
after each scan checkbox. 

Scanning Settings 
The Scanning Settings properties page (ALT+G, C) contains 
all the controls that affect the way OpenBook scans pages. 
These options are listed below. 
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Scanning Mode 
Scanning Mode is one of the most important and frequently 
used items. Therefore, we have given you other ways to get 
to the Scanning Mode list. From anywhere in the document, 
you can press SHIFT+F10 to bring up the Scanning Mode 
list. If you are a mouse user, simply click the right mouse 
button and click on the mode you want. 

Your options are: 

Scan and Read 
Scan and Read lets you first scan a page, then read it. When 
you first use OpenBook, your scanning options are set to 
Scan and Read. This setting is best for quickly reading short 
documents, such as letters and recipes. 

Scan in Background 
If you have a hardware synthesizer, such as DECtalk PC or 
DECtalk Express you may want to use the Scan in 
Background feature as this allows you to scan one page and 
read another. 

The document you are scanning may be the same as the 
document you are reading, or you may scan into one 
document, then open and read another. 

When OpenBook is ready to scan another page, you will 
hear a small musical tone. Place the next page on the 
scanner, and press F4. OpenBook continues to read while 
the next page is scanned. 
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Large Batch 
Large Batch scanning is helpful because it automates 2/3 of 
the process allowing you to move on to some other activity. 
So while you must be a captive participant in the scanning 
process, OpenBook offers you freedom during the 
preparation and recognization process. 

After each scan is complete, a Batch dialog opens giving you 
four options. Press TAB to move among the four buttons and 
press SPACEBAR to activate the button. 

Your choices are: 
• Scan Another Page 
• Done Scanning 
• Suspend Scanning 
• Cancel Scanning 

If you are using an Automatic Document Feeder (ADF), the 
process is even more automated. You can place batches of 
20 to 25 pages in an ADF, and scan them as a group. 
Please note that if you are scanning documents that contain 
text on both sides of the paper, you must scan the backs of 
the pages in reverse order so that OpenBook can match 
them up correctly. 

Batch in Background 
If you have a hardware synthesizer, such as DECtalk PC or 
DECtalk Express you may want to use the Batch in 
Background feature as this feature offers you the 
combination of Scanning in the Background with Large Batch 
features. 
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Express Batch 
Express Batch is a simpler version of Large Batch scanning. 
While Large Batch prompts you for another page, Express 
Batch skips these prompts, resets itself, and scans 
automatically until you press ESC. This means you must 
listen for the scanner resetting itself at the top of the flatbed, 
then place a new page on the scanner. 

In order to increase the time span between each scan, open 
the Scanning Settings Properties page (ALT+G, C), and 
press ALT+X or TAB until you hear Express Batch Delay 
combo box. Use your DOWN ARROW key to increase the 
time in second increments. 

As with Large Batch, once scanning is completed, 
OpenBook prepares and recognizes the pages allowing you 
to do something else. Express Batch is well suited for people 
who are familiar with their scanner and want to scan a large 
document quickly. Do not use this mode with an ADF. 

Image Only 
Image Only scans the page and saves it as an image file, 
without performing the recognition process. This setting is 
useful if you want to create and save an image file to be 
used later as a graphic. 

Fax Files 
Fax Files allows you to recognize files that you have 
received via a fax card. For the best possible recognition, be 
sure to get a fine fax image of 200 x 200 dpi, and save the 
file in PCX, DCX or TIFF format. When you choose this 
scanning mode, you will need to tell OpenBook where to find 
the file you want to recognize. 
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You can also open a fax (.PCX) file by choosing Open from 
the File menu or pressing CTRL+O. In the Files of Type 
combo box, select Image Files. Locate and open the fax file. 
OpenBook automatically recognizes the text of the fax. 

Orientation Only 
Orientation Only scans a page and determines its orientation 
without proceeding to the recognition process. This setting is 
useful when you are scanning a large document. You can 
use Orientation Only to determine the orientation of the first 
page, and then set the Page Orientation to the correct 
setting. This will speed up the scanning process. 

Express Batch in Background 
If you have a hardware synthesizer, such as DECtalk PC or 
DECtalk Express you may want to use the Express Batch in 
Background feature as this feature offers you the 
combination of Scanning in the Background with Express 
Batch features. 

To increase the time span between each scan, open the 
Scanning Settings Properties page (ALT+G, C), and press 
ALT+X or TAB until you hear Express Batch Delay combo 
box. Use your DOWN ARROW key to increase the time in 
second increments. 

In order to read your documents while scanning, you need to 
let OpenBook process some documents. Otherwise reading 
will stop as unprocessed pages are encountered. 

To stop scanning, press the F4, SPACEBAR, or NUM PAD 
INSERT again. When scanning has stopped, you will be 
given the opportunity to process the newly added batch of 
documents. 
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Scanning Contrast 
Scanning Contrast controls the light-to-dark contrast ratio in 
the scanned document. 

To use Scanning Contrast: 
1. 	Press ALT+G or click on the Settings Menu. Then 


press C or select Scanning Settings to open the 

Scanning Settings Properties page. 


2. 	Press TAB or ALT+C to move to the Scanning Contrast 
combo box. 

3. 	Use the UP or DOWN ARROW keys to make a 

selection. 


4. 	 Last, if you want to make more setting changes press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 

Your choices are: 

Automatic Contrast 
OpenBook will individually evaluate each page to determine 
the best contrast setting for maximum accuracy. This is 
useful if you have mystery pages to scan. This setting adds 
to the scanning time. 

Normal Contrast 
This corresponds to a value of 127. This setting works for 
most books and memos or anything with reasonably good 
black print on white paper. 

Darken Page 
Darken Page is useful for print that is too light. An example 
of this is when OpenBook reads "iii" instead of the letter "m." 
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Lighten Page 
Lighten Page is useful for print that is too dark. An example 
of this is when OpenBook reads the letter "m" instead of the 
letters "r" and "n." 

Custom 
Contrast choices include a series of numbers from 0 to 255. 
Custom contrast settings can increase accuracy if you have 
a page that is outside the range of the other options. Low 
numbers make it darker, and high numbers make it lighter. 

Page Orientation 
Page Orientation controls how the scanner recognizes the 
page orientation. The correct orientation setting speeds up 
the scanning process. You have five orientation choices (the 
instructions are for HP scanners). Use the UP or DOWN 
ARROW keys to make your selection. 

To use Page Orientation: 
1. 	Press ALT+G or click on the Settings Menu. Then 


press C or select Scanning Settings to open the 

Scanning Settings Properties page. 


2. 	Press TAB or ALT+P to move to the Page Orientation 
combo box. 

3. 	Use the UP or DOWN ARROW keys to make a 

selection. 


4. 	 Last, if you want to make more setting changes press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 

Your Page Orientation choices are: 

118 



Automatic 
Automatically determines which way the page is oriented on 
the scanner. This is the easiest setting but it can add to the 
scanning time. 

Normal 
Use this setting when you orient the top of the page with the 
rear edge of the scanner's glass plate. 

Sideways 
Use this setting when you orient the top of the page with the 
right side of the scanner's glass plate. 

Upside-down 
Use this setting when you orient the top of the page with the 
front edge of the scanner's glass plate. 

Sideways Upside-down 
Use this setting when you orient the top of the page with the 
left side of the scanner's glass plate. 

Scanning 
Resolution is measured in dots per inch (dpi). The higher the 
resolution, the more dots per inch resulting in larger image 
files. 
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Many scanners have a standard setting of 300 dots per inch 
(dpi). However, if you are reading pages printed in very small 
type and have a scanner that can resolve as finely as 400 
dpi, you may see improved recognition accuracy. For 400 dpi 
to be effective, your scanner must have an optical resolution 
of at least 400 by 400 dpi. An optical resolution of 300 by 
600 dpi is not adequate. The point range for fonts with a 300 
dpi scanner is 6 to 24 points; for a 400 dpi scanner, the 
range is 4 to 24 points. 

To change scanning resolution: 
1. 	Press ALT+G or click on the Settings Menu. Then 


press C or select Scanning Settings to open the 

Scanning Settings Properties page. 


2. 	Press TAB to move to the Scanning combo box. 
3. 	Use the UP or DOWN ARROW keys to make your 


selection. 

4. 	 Last, if you want to make more setting changes press 

ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 

Recognize Text Using 
Use this control to select your Optical Character Recognition 
(OCR) Engine. OCR is how a scanner translates the 
scanned information into speech and screen text. 
OPENBook offers three different engines to choose from.  

To select an OCR Engine: 
1. 	Press ALT+G or click on the Settings Menu. Then 


press C or select Scanning Settings to open the 

Scanning Settings Properties page. 


120 



2. 	Press TAB or ALT+U to move to the Recognize Text 
Using combo box. 

3. 	Use the UP or DOWN ARROW keys to make a 
selection. 

4. 	 Last, if you want to make more setting changes press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 

Your choices are: 

OmniPage 
This OCR engine quickly recognizes text with a high degree 
of accuracy. 

Recognita 
Use this OCR engine when you are scanning for speed, and 
your document is written in a supported foreign language. 

Fine Reader 
Fine Reader is set as OpenBook's default engine because it 
is one of the most accurate OCR engines on the market. It 
will recognize more than 170 languages, including Eastern 
European, programming and artificial languages. However, 
on a slow system you may want to use another engine to 
speed up performance. 
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Text Type 
Use this item if you are scanning pages that were printed on 
a Dot Matrix printer or on a typewriter that doesn't use 
proportional spacing. Such pages may not scan clearly 
using the Normal Text setting. Selecting Typewritten or Dot 
Matrix Text may help OpenBook read these pages more 
successfully. Use the UP or DOWN ARROW keys to make 
your selection. Your choices are: Normal Text, Typewritten 
or Dot Matrix Text. 

To select a Text Type: 
1. 	Press ALT+G or click on the Settings Menu. Then 

press C or select Scanning Settings to open the 
Scanning Settings Properties page. 

2. 	Press TAB or ALT+E to move to the Recognize Text 
Using combo box. 

3. 	Use the UP or DOWN ARROW keys to make a 

selection. 


4. 	 Last, if you want to make more setting changes press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 
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Recognition Languages 
Primary and Secondary Languages 
This control sets the primary language that the OCR engine 
identifies during the scanning process, not the language for 
OpenBook speech. This option is useful if the document you 
are scanning has text that contains accent marks, umlauts, 
or other characters unique to a particular language. The 
languages listed will vary depending on the languages 
installed with OpenBook, but always includes the 13 Western 
European languages. 

To change the primary and secondary recognition language: 
1. 	Press ALT+G or click on the Settings Menu. Then 


press C or select Scanning Settings to open the 

Scanning Settings Properties page. 


2. 	 To move to the Recognition Language combo box, 

press TAB or ALT+G. To move to the Secondary 

Language combo box, press TAB or ALT+Y. 


3. 	Use the UP or DOWN ARROW keys to make a 

selection. 


4. 	 Last, if you want to make more setting changes, press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or, exit this properties page by pressing 
ENTER. 

Image Format 
You can specify the file format you want to save an image as 
when scanning in Image Only mode. Your choices are PCX 
and several types of TIFF formats. 

To select an Image Format: 
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1. 	Press ALT+G or click on the Settings Menu. Then 

press C or select Scanning Settings to open the 

Scanning Settings Properties page. 


2. 	Press TAB or ALT+F to move to the Image Format 
combo box. 

3. 	Use the UP or DOWN ARROW keys to make a 

selection. 


4. 	 Last, if you want to make more setting changes, press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or, exit this properties page by pressing 
ENTER. 

Setting Document Boundaries 
The Left, Right, Top, and Bottom boundaries determine how 
much of the page OpenBook should recognize, by defining 
the distance from the side of the page. This tells OpenBook 
to ignore anything outside that boundary. The standard 
setting for all four boundaries (left, right, top, and bottom) is 
zero, which means that the entire page will be scanned and 
recognized. 

To define a boundary: 
1. 	Press ALT+G or click on the Settings Menu. Then 


press C or select Scanning Settings to open the 

Scanning Settings Properties page. 


2. 	Press TAB until you hear left boundary and type a 

number, which reflects inches, in the edit box. 


3. 	 Repeat the above steps if you want to set the right, top, 
and bottom boundaries. 
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4. 	 Last, if you want to make more setting changes, press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or, exit this properties page by pressing 
ENTER. 

Batch Images Location 
Use the Batch Images Location edit box to specify the 
folder you want OpenBook to use to temporarily store 
images of scanned documents during batch scanning. Enter 
the complete file path for the folder. By default, images of 
scanned documents are stored in the Images folder of your 
OpenBook directory. 

De-skew 
De-skew corrects as much as ten degrees of skew in a 
crooked page, straightening up to three quarters of an inch 
for a standard eight-and-a-half inch page. Use this option if 
you are concerned that the page is on the scanner slightly 
crooked, or skewed. It is also helpful when reading 
documents that have been photocopied, since the text may 
not be perfectly straight on the page. However, de-skewing 
will add a few seconds to the scan time. When you install 
OpenBook this box is checked by default. 

To deactivate De-skew: 
1. 	Press ALT+G or click on the Settings Menu. Then 

press C or select Scanning Settings to open the 
Scanning Settings Properties page. 

2. 	Press ALT+D or click on De-skew to uncheck the box. 
3. 	 To check the box, simply press ALT+D or click on De­

skew. 
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4. 	 Last, if you want to make more setting changes press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 

De-speckle 
De-speckle corrects a page with an unclean or unclear 
background, such as a page that has been photocopied 
several times or a newspaper article. When you install 
OpenBook this box is checked by default. 

To deactivate De-speckle: 
1. 	Press ALT+G or click on the Settings Menu. Then 

press C or select Scanning Settings to open the 
Scanning Settings Properties page. 

2. 	Press ALT+K or click on De-speckle to uncheck the 
box. 

3. 	 To check the box, simply press ALT+K or click on De­
speckle. 

4. 	 Last, if you want to make more setting changes, press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or, exit this properties page by pressing 
ENTER. 

White on Black 
Allows OpenBook to scan and recognize white text on a 
black background. This is useful when reading packaged 
food boxes or magazines that often use light text on a dark 
background for emphasis. When you install OpenBook this 
box is checked by default. 

To deactivate the White on Black control: 
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1. 	Press ALT+G or click on the Settings Menu. Then 
press C or select Scanning Settings to open the 
Scanning Settings Properties page. 

2. 	Press ALT+W or click on White on Black to uncheck 
the box. 

3. 	 To check the box, simply press ALT+W or click on 
White on Black. 

4. 	 Last, if you want to make more setting changes, press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or, exit this properties page by pressing 
ENTER. 

Language Analyst 
Language Analyst improves scanning accuracy on difficult 
pages. However, this feature may slow the recognition 
process. When you install OpenBook this box is checked by 
default. 
1. 	Press ALT+G or click on the Settings Menu. Then 

press C or select Scanning Settings to open the 
Scanning Settings Properties page. 

2. 	Press ALT+L or click on Language Analyst to uncheck 
the box. 

3. 	 To check the box, press ALT+L or click on Language 
Analyst. 

4. 	 Last, if you want to make more setting changes, press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or, exit this properties page by pressing 
ENTER. 
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Discard Blank Pages 
Check this box if you want OpenBook to throw away 
scanned pages that are blank. Note that sometimes you will 
want to keep blank pages so that you can maintain the 
original page numbering and order. The default is 
unchecked. 
1. 	Press ALT+G or click on the Settings Menu. Then 

press C or select Scanning Settings to open the 
Scanning Settings Properties page. 

2. 	Press ALT+B or click on Discard Blank Pages to 

uncheck the box. 


3. 	 To check the box, simply press ALT+B or click on 
Discard Blank Pages. 

4. 	 Last, if you want to make more setting changes, press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or, exit this properties page by pressing 
ENTER. 

Emphasis Text 
OpenBook recognizes text that is bold, underlined, or in 
italics. This item is disabled by default. 

To enable Emphasis Text: 
1. 	Press ALT+G or click on the Settings Menu. Then 

press C or select Scanning Settings to open the 
Scanning Settings Properties page. 

2. 	Press TAB until you hear, “Emphasis Text,” then press 
the SPACEBAR to uncheck the box. 

3. 	 To check the box, simply press SPACEBAR again. 
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4. 	 Last, if you want to make more setting changes, press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or, exit this properties page by pressing 
ENTER. 

Uncertain Text 
Uncertain Text tells OpenBook to indicate when it 
encounters a word or character it is unsure about by using 
the Uncertain Text Marker (see next item). When you start 
OpenBook, this box is unchecked by default. 
1. 	Press ALT+G or click on the Settings Menu. Then 


press C or select Scanning Settings to open the 

Scanning Settings Properties page. 


2. 	Press TAB until you hear Uncertain Text, then press 
the SPACEBAR to uncheck the box. 

3. 	 To check the box, simply press SPACEBAR again. 
4. 	 Last, if you want to make more setting changes press 

ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 

Uncertain Text Marker 
Designate a specific character, such as an asterisk, to be 
spoken when OpenBook finds a word or character that is 
unclear. When you install OpenBook Uncertain Text is set to 
Asterisk (*). 

To designate a text marker: 
1. 	Press ALT+G or click on the Settings Menu. Then 


press C or select Scanning Settings to open the 

Scanning Settings Properties page. 
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2. 	Press ALT+N or TAB until you hear, “Uncertain Text 
Marker,” then type the character you want as the 
marker. 

3. 	 Last, if you want to make more setting changes press 
ALT+A or TAB to the Apply button and press the 
SPACEBAR. Or exit this properties page by pressing 
ENTER. 
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Book 22 
OpenBook with Multiple Users 

Enabling Multiple Users 
For those environments where there are many OpenBook 
users, but only one computer, OpenBook allows for more 
than one user to login and have their individual preferences, 
settings, and library. Select enable Multiuser Login from the 
Advanced Menu (ALT+A) to switch between multiuser and 
single-user mode. When you uncheck this item, OpenBook 
switches to single-user mode, and does not display the User 
Log In screen when you launch the program. 

Note:	 This item is always enabled in the network version of 
OpenBook. 

It is good practice for an OpenBook user who is in a public 
setting to log off when they are done working. This way the 
next user can easily login. To log off, go to the File Menu 
(ALT+F) and select the Log Off menu item. This opens the 
Log In dialog, which prepares OpenBook for the next user 
login. 

Logging In 
The Log In dialog is only available when the Multiuser Login 
is enabled in the Advanced Menu. If you have never logged 
in as a user you will need to type in your name and then 
press TAB to move to the Ok button. When you arrive at the 
Ok button, press ENTER. 
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If you have previously logged in as a user, your login name 
will be among the names in the ‘Please Sign In Here’ combo 
box. In this case, use the UP or DOWN Arrow key to locate 
your name or simply press the first letter of your name until 
you see and/or hear it spoken. Next, press TAB to move to 
the Ok button. When you arrive at the Ok button, press 
ENTER. 
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Book 23 
Classic Menus 

OpenBook’s original design used a separate numeric NUM 
PAD for command input to the Classic Menus. Over time 
OpenBook evolved to include Windows® keyboard 
functions. If you are one of the original OpenBook users: 
First, we thank you for your loyalty to OpenBook; second, 
the numeric NUM PAD input and the Classic Menus are still 
available and here’s a refresher on how they work together. 

OpenBook and the Numeric Pad 
Top Row 

NUM LOCK 
Toggles between the Standard Menus and the Classic 
Menus, which allows you to choose different options and 
change OpenBook's settings. 

Forward Slash key (/) 
Indicates the scanning status for a page that is currently 
being scanned. If you are not scanning, it indicates that no 
page is being scanned. This key is also a toggle key. 

Asterisk key (*) 
Allows you to change the voice speed while reading a 
document. Press the Asterick key to read faster, or the 
keyboard SHIFT key to read slower. OpenBook will say 
“faster” or “slower.” 
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Minus key (-) 
Presents you with OpenBook's on-line manual, which has a 
list of Help Topics. This key is also a toggle key. 

Second row: 

Home key (7) 

Explains where you are in the reading process or in the 
menus. Press it while in a menu, and it will tell you what 
menu you are in. Press it while in a document, and it will list 
the line and page number you are on. 

Up Arrow key (8) 
Moves you up one line if you are reading a page, or up one 
choice if you are in a menu. 

Page Up key (9) 
If there is a previous page, the Page Up key moves to the 
previous page in the document. If you are in a List Field on a 
menu, it moves you to the previous group of items in the list. 

Plus (+) key 
Exits the current activity or allows you to leave a menu or 
Help when you are finished with it. 

Note: If you are scanning a page, the Plus key will not stop 
the scanning process. To interrupt scanning, press the 
Scan key (Insert key). 
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Third row: 
Left Arrow key (4) 
is the Move Left key. This key moves you back a word 
while you are reading. (Note: if you have changed the 
Movement Unit, Move Left may move you back a letter, a 
sentence, a line, or a paragraph.) To go a long way back, 
hold the Move Left key down, and you will quickly move 
backward through the page. OpenBook will not speak the 
text as you skim through it, but once you stop, it will say the 
word the cursor is on. To begin reading again, press the 
Speak key. 

Center Key (5) 
Selects the current choice in a menu or in a dialog box. If 
you are reading, press this key once and OpenBook speaks 
the word the cursor is on. Press it again and OpenBook 
spells the word aloud. Press it a third time to spell the word 
with the military alphabet, using words like Alpha, Bravo, and 
Charlie for the letters A, B and C. The Select key's spelling 
functionality also works when you are in a dialog box, to read 
and spell information in fields and button names. 

Right Arrow key (6) 
is the Move Right key. This key moves you forward a word 
while you are reading. (Note: if you have changed the 
Movement Unit, Move Left may move you forward a letter, a 
sentence, a line, or a paragraph.) To go a long way forward, 
hold the Move Right key down, and you will quickly move 
through the page. OpenBook will not speak the text as you 
skim through it, but once you stop, it will say the word the 
cursor is on. 

To begin reading again, press the Speak key. 
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Fourth row: 
End key (1) 
Describes the function of the other keys. Press this key and 
the other keys become inactive; then press any key and 
OpenBook will announce the key's name or function. 
Pressing the End Key again returns the NUM PAD to its 
normal function. 

Down Arrow key (2) 
Moves you down one line if you are reading a page, or down 
one choice if you are in a menu. 

Page Down key (3) 
Moves to the next page in the document (if there is one). If 
you are in a List Field on a menu, it moves you to the next 
group of items in the list. 

ENTER key 
Starts and stops reading, interrupts speech, or repeats the 
current item in a menu or dialog box. The Speak key also 
works when you are in a dialog box, to announce button 
names or information in fields. 

Bottom row: 
INSERT key (0) 
Starts or stops scanning. 

DELETE key (.) 
Deletes the current page you are reading, or deletes a 
character when you are typing an entry, such as a file name. 

136 



Classic Menus: 
Advanced Menu Level 

Read a Document (File menu: Open) -- this option opens 
and reads a previously named document. 

Create a New Document -- this option creates a new 
document. You can then scan pages into it. 

Scanning Options (Settings menu: Scanning Settings) --
this menu controls how OpenBook scans. There are several 
choices on this menu. 

Scanning Mode -- this option gives severall ways to control 
the scanning process. Your choices are: 

Scan and Read -- this is the standard mode: OpenBook 
scans the page, then reads it aloud. 

Scan in Background -- this mode scans one page while you 
are reading another. 

Large Batch -- this mode divides the scanning process into 
Scanning, the step that requires your participation to turn the 
pages and Recognition, the step that takes more time, but 
can be performed while you do something else. 

Batch in Background -- this mode allows you to scan a 
series of pages using Large Batch mode, and while you are 
scanning, read another document. 

Express Batch -- Similar to Large Batch, this mode skips 
the scanning prompts, allowing you to listen for the sound of 
the scanner head reaching the bottom of the flatbed, and 
returning to the top. 

Image Only -- this mode scans a page and saves it as an 
image file, without performing the recognition process. 
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Fax Files -- this mode performs the recognition process on 
Fax or other image files. 

Two Page (Note: this item is new to the Classic Menus) ­
- this mode scans two side-by-side pages of an OpenBook in 
a single scan. 

Orientation only -- This mode scans a page, and 
determines its orientation. 

Scanning Contrast -- this option allows you to control the 
level of contrast in the scanned page. Your choices are: 
• Automatic Contrast 
• Normal Contrast 
• Darken Page 
• Lighten Page 
• Custom Contrast 

Page Orientation -- this option allows you to select how 
OpenBook will handle pages that are upside-down or 
sideways. Your choices are: 
• Automatic 
• Normal 
• Sideways 
• Upside Down 
• Sideways Upside Down 

Scanning Boundaries -- this option specifies which portion 
of the page should be recognized, by defining the distance 
from a specific side of the page, and telling OpenBook to 
ignore anything outside the boundary area. You can control 
four boundaries: 
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• Left Boundary 
• Right Boundary 
• Top Boundary 
• Bottom Boundary 

Scanning Resolution -- this option controls how fine a 
picture of the page is made by the scanner. Your choices 
are: 
• 300 dots per inch 
• 400 dots per inch 

Text De-skew -- this option determines whether the scanner 
will compensate for up to 10 degrees of skew on a page. 
Your choices are: On/Off 

Language Analyst -- this option improves the quality of text 
recognition on difficult pages. Your choices are: On/Off 

ScanFix -- this option helps get the best scan possible by 
performing additional work on the scanned images. Your 
choices are: On/Off 

Text Type -- this option allows you to choose between two 
types of print formats. Your choices are: 
• Normal text 
• Typewriter or Dot matrix 

Text Flags (Note that in Windows menus, Bold, Italics, 
and Underline are grouped under the term Emphasis) --
this option, when used with a speech synthesizer, tells 
OpenBook to indicate words that were emphasized on the 
original page by using a different voice for "Bold," "Italic," 
Underlined," or "Uncertain text." Your choices are: 
• Bold text - On/Off 
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• Italic text - On/Off 
• Underlined text - On/Off 
• Uncertain text - On/Off 

Uncertain text flag -- This option allows you to designate a 
specific character, such as an asterisk, that will be spoken 
when OpenBook finds a word or character it is unsure about. 

Image Format -- This option allows you to choose into which 
format a scanned image will be saved. Most OpenBook 
users will use this setting to create Fax images. Your 
choices are: 
• PCX 
• TIFF G3 Modified 
• TIFF G3 
• TIFF G4 
• TIFF Packbits 
• TIFF Uncompressed 

Recognition Language -- this option lets you choose which 
language to use when recognizing text. 

Library (File menu: Library) -- this menu allows you to 
create new documents, open or close them, save them, 
delete them, or open and read document files from many 
popular word processing programs. There are several 
choices on this menu. 

Read a Document -- this option opens and reads a 
previously named document. 

Create a New Document -- this option creates a new 
document and then scans pages into it immediately. 
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Close Document -- this option closes a named document. 

Save Document -- this option saves and names a 
document. 

Convert Document -- this option converts an OpenBook 
document to a PC word processor, ASCII, or PC 
spreadsheet format. 

Delete a Document -- this option deletes a document. 

Create a New Category -- this option creates and names 
new categories. 

Delete a Category -- this option removes obsolete 
categories. 

Read a File -- this option reads many files on your hard or 
floppy drive, including word processing, spreadsheet, and 
ASCII files. 

Reading Options -- this menu controls how OpenBook 
reads the page. 

Go To Page (Edit Menu: Go To Page) -- this option moves 
to a specified page in the document and begins reading. 

Find Text (Edit Menu: Find) -- this option searches for and 
locates a specified word or phrase in the document. 
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Movement Unit (Settings Menu: General Settings) -- this 
option affects how the text is highlighted during reading. 
When you use the Speak key to have OpenBook read 
continuously, the spotlight cursor will highlight the unit as 
OpenBook reads to you. OpenBook will not stop or pause at 
the end of each Movement Unit. If you want OpenBook to 
read Unit by Unit, use the Control key with the right arrow 
key. OpenBook will then stop at after each Unit and wait for 
you to press Control plus right arrow again. This is a useful 
way to review text for readability. Your choices are: 
• Word 
• Sentence 
• Line 
• Paragraph 

Speech (Settings Menu: Speech Settings) -- this option 
lets you control whether OpenBook speaks or not. Your 
choices are: 
• Text -- On/Off 
• Menus -- On/Off 

Voice Settings (Settings Menu: Speech Settings) -- this 
option changes the voice rate, pitch, or voice used for the 
three voices. Each voice has the following choices: 

Voice Rate -- this option changes how fast OpenBook 
speaks. 

Voice Volume -- this option changes how loud OpenBook 
speaks. 

Voice Pitch -- this option changes how high or low 
OpenBook speaks. 
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Voice Tone -- this option changes how much inflection 
OpenBook uses when speaking. 

Punctuation Announcement -- this option determines how 
much of the punctuation OpenBook speaks. 

Voice Selections -- this option selects the basic voice that 
all the other settings modify. 

Voice Language -- this option selects which language is 
used for OpenBook's reading voice. 

Voice Speech -- On/Off 

Visual Settings (Settings Menu: Visual Settings) -- this 
option alters the way text is presented on the screen. You 
can modify the following visual features: 
•	 Text Font 
•	 Text Size 
•	 Text Color 
•	 Background Color 
•	 Cursor Color 
•	 Cursor Background Color 
•	 Left Margin (Note: this item is new to the Classic 

Menus) 
•	 Right Margin (Note: this item is new to the Classic 

Menus) 
•	 Extra Spacing Between Characters (Note: this item is 

new to the Classic Menus) 
•	 Extra Spacing Between Words (Note: this item is new 

to the Classic Menus) 
•	 Extra Spacing Between Lines (Note: this item is new to 

the Classic Menus) 
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•	 Extra Spacing Between Sentences (Note: this item is 
new to the Classic Menus) 

OpenBook Options -- this menu controls various OpenBook 
features. 

Menu Level (Settings Menu: General Settings) -- this 
option changes OpenBook's level of difficulty. Your choices 
are: 
•	 Advanced menus 
•	 Beginner menus 

Tones (Settings Menu: General Settings) -- this option 
controls the beeps that OpenBook makes while scanning. 
Your choices are: On/Off 

Progress Messages (Settings Menu: General Settings) --
this option controls the messages that OpenBook speaks as 
it is processing the page. Your choices are: On/Off 

Announce Shortcut Keys (Settings Menu: General 
Settings) -- this option determines whether OpenBook 
announces the keyboard shortcut immediately after speaking 
the menu option. Your choices are: On/Off 

Save the Settings (Settings Menu: Save the Settings) --
this option allows OpenBook to save current settings. 

Retrieve the Settings (Settings Menu: Retrieve Settings) 
-- this option retrieves and activates any saved settings files, 
including the Default file. 

Delete the Settings (Settings Menu: Delete Settings) --
this option deletes named settings files (except for Default). 
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Exit to Windows (File Menu: Exit) -- this option closes 
OpenBook and returns you to Windows. Your choices are: 
No, don't exit or Yes, exit. 

Quit and Shut Down (does not exist in Windows menus) 
-- this option closes OpenBook shuts down Windows, and 
turns off your computer. Your choices are: No, don't quit or 
Yes, quit. 

Help (Help Menu) -- this menu offers several forms of help. 
When you select Help, OpenBook presents a list of the 
manual chapters. Use the arrow keys to select the topic you 
want to open and read. 

List of recently read files (File menu: list of recently read 
files) -- this option lists up to five of the most recently read 
documents. 

Classic Menus: 
Beginner Menu Level 

Note that the Beginner level contains only a very limited 
number of menu topics. If you want to use other topics, you 
should go to the OpenBook Options, choose Menu Level, 
and select Advanced Menus. 

Reading Options-- this menu controls how OpenBook reads 
the page. 

Go To Page (Edit Menu: Go To Page) -- this option moves 
to a specified page in the document and begins reading. 

Voice Settings (Settings Menu: Speech Settings) -- this 
option changes the voice rate, pitch, or voice used for the 
Reading Voice. You have the following choices: 

Voice Rate -- this option changes how fast OpenBook 
speaks. 
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Voice Pitch -- this option changes how high or low 
OpenBook speaks. 

Voice Selections -- this option selects the basic voice that 
all the other settings modify. 

Text Size (Settings Menu: Visual Settings) -- this option 
alters the size of the text presented on the screen. 

OpenBook Options -- this menu controls various OpenBook 
features. 

Menu Level (Settings Menu: General Settings) -- this 
option changes OpenBook's level of difficulty. Your choices 
are: 
• Advanced menus 
• Beginner menus 

Save the Settings (Settings Menu: Save the Settings) --
this option allows OpenBook to save current voice settings. 

Exit to Windows (File Menu: Exit) -- this option closes 
OpenBook and returns you to Windows. Your choices are: 
No, don't exit or Yes, exit. 

Quit and Shut Down (does not exist in Windows menus) 
-- this option closes OpenBook shuts down Windows, and 
turns off your computer. Your choices are: No, don't quit or 
Yes, quit. 

Help (Help Menu) -- this menu offers several forms of help. 

Select this item to open the Help Topics list and read the 
OpenBook manual on-line. When you select Help Topics, 
OpenBook presents a list of the manual chapters. Use the 
arrow keys to select the topic you want to open and read. 
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Book 24 
OpenBook Keyboard Layout 

Reading Keys 
Read Dialog 

Read Status Bar 

Reading speed -- decrease 

Reading speed -- increase 

Read (Say All) 

Speech On/Off toggle 

Scanning Keys 
Toggle Recognize Columns 

Scan (Edit Mode) 

Scan (Read-only Mode) 

Scanning Status 

Movement Keys 
Find text 

Find next occurrence of text 

CTRL+B 

CTRL+SHIFT+F10 

CTRL+1 or SHIFT NUM PAD 
ASTERISK 

CTRL+2 or 
NUM PAD ASTERISK 

F10, F12 or 
NUM PAD ENTER 

CTRL+F5 

CTRL+SHIFT+Z 

F4 or NUM PAD INSERT 

SPACEBAR, F4, or 
NUM PAD INSERT 

SHIFT+F4 or 
NUM PAD SLASH 

CTRL+F 

CTRL+SHIFT+F 
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Go To Bookmark F9 

Go To Page CTRL+G 

Where Am I NUM PAD 7 

Move Up One Line UP ARROW 

Move Down One Line DOWN ARROW 

Move Forward One 
Character (Edit Mode) RIGHT ARROW 

Move Back One Character 
(Edit Mode) LEFT ARROW 

Move Forward One Word 
(Read-only Mode) RIGHT ARROW 

Move Back One Word 
(Read-only Mode) LEFT ARROW 

Move Up One Page NUM PAD PAGE UP 

Move Down One Page NUM PAD PAGE DOWN 

Move Up One Screen PAGE UP 

Move Down One Screen PAGE DOWN 

Highlight Next Word in the 
Unit CTRL+DOWN ARROW 

Highlight Prev. Word in the 
Unit CTRL+UP ARROW 

Move Spotlight to Previous 
Unit CTRL+LEFT ARROW 

Move Spotlight to Next Unit CTRL+RIGHT ARROW 
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Move Spotlight to beg. of 
doc CTRL+HOME 

Move Spotlight to end of 
doc CTRL+END 

Select Line Down SHIFT+DOWN ARROW 

Select Line Up SHIFT+UP ARROW 

Select Page Down 
(view page) SHIFT+PAGE DOWN 

Select Page Up (view page) SHIFT+PAGE UP 

Select word to the right 
(Read-only Mode) SHIFT+RIGHT ARROW 

Select character to the right 
(Edit Mode) SHIFT+RIGHT ARROW 

Select word to the left 
(Read-only Mode) SHIFT+LEFT ARROW 

Select character to the left 
(Edit Mode) SHIFT+LEFT ARROW 

Select to beginning of Word 
(Edit Mode) CTRL+SHIFT+LEFT ARROW 

Select Word to the left 
(Read-only Mode) CTRL+SHIFT+LEFT ARROW 

Select to end of word CTRL+SHIFT+RIGHT 
(Edit Mode) ARROW 

Select to beginning of page CTRL+HOME 

Select to end of page CTRL+END 
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Select to beginning of line SHIFT+HOME 

Select to end of line SHIFT+END 

Editing Keys 
Copy text CTRL+C 

Cut text (Edit mode) CTRL+X 

Delete Current Page CTRL+DELETE 

Delete Character DELETE 

Dictionary CTRL+D or F8 

Edit Mode/Read-only Mode 
toggle CTRL+E 

Move Page Down in page 
order ALT+PAGE DOWN 

Move Page Up in page 
order ALT+PAGE UP 

Page Break, Insert CTRL+ENTER 

Page Break, Delete CTRL+SHIFT+DELETE 

Paste text (Edit mode) CTRL+V 

Replace text (Edit Mode) CTRL+H 

Select All text on current 
page (Edit Mode) CTRL+A 

Spell Check F7 or CTRL+K 

Spell Word CTRL+L, F3 twice, or NUM 
PAD 5 twice 
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Spell Word Phonetically 

Thesaurus 


Undo 


Page Layout Keys 
Start Page Description 

Enter Guided Layout Mode 

Exit Guided Layout Mode 

Enter Explore Layout Mode 

Enter Explore Layout Mode 
from Guided Layout Mode 

Exit Explore Layout Mode 

Exit Explore Layout Mode 
and place cursor at current 
element in editor 

Pause/Resume Reading 
in Guided Layout Mode 

Read Element Contents/ 
Pause Reading/Resume 
Reading element contents 
in Explore Layout Mode 

Exact View / Text View 
Toggle 

CTRL+SHIFT+L, F3 three 
times, or NUM PAD 5 three 
times 

CTRL+T or SHIFT+F8 

CTRL+Z 

CTRL+SHIFT+Y 

CTRL+SHIFT+F5 

ESC 

CTRL+SHIFT+ENTER 

ENTER 

ESC 

ENTER 

NUM PAD ENTER 

NUM PAD ENTER 

CTRL+SHIFT+V 
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Move to Next Element 

Move to Previous Element 

Other Useful Keys 
Bookmark, go to 

Bookmark, insert 

Bookmark, delete 

BuckScan money identifier 

Classic menus toggle On/Off 

Close current document 

Document Properties 

Exit OpenBook 

Help 

Help, context-sensitive help 

Key Describer toggle 

Menu key (Classic menus) 

New File 

Open File 

Print current document 

Properties 
(of open document) 

Save current document 

CTRL+SHIFT+DOWN 
ARROW 

CTRL+SHIFT+UP ARROW 

F9 

CTRL+F9 

CTRL+SHIFT+F9 

CTRL+M 

F2 

CTRL+F4 or CTRL+W 

CTRL+R 

ALT+F4 

F1 or NUM PAD MINUS 

SHIFT+NUM PAD MINUS or 
SHIFT+F1 

NUM PAD 1 or CTRL+F12 

NUM LOCK 

CTRL+N 

CTRL+O 

CTRL+P 

CTRL+R 

CTRL+S 
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Status Bar toggle On/Off SHIFT+F5 

Start Open Book ALT+CTRL+O 

Toggle Windows CTRL+F6 

Word Count SHIFT+F7 

Using the NUM PAD on a portable PC 
You can use OpenBook on a portable notebook or laptop 
computer. However, most portable computers do not have 
standard 17-key keypads. We have therefore assigned 
alternate keys to the OpenBook NUM PAD functions. 

Menu F2 

Scan F4 or SPACEBAR 

Delete Page CTRL+DELETE 

Speak F10 or F12 

Select ENTER 

Escape ESC 

Key Describer CTRL+F12 

Where Am I? SHIFT+CTRL+F12 

Help F1 

Voice Rate CTRL+1 and CTRL+2 

Scanning Status SHIFT+F4 

Move Up UP ARROW 

Move Down DOWN ARROW 

Move Left LEFT ARROW 
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Move Right RIGHT ARROW 

Page Up PAGE UP 

Page Down PAGE DOWN 
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Book 25 
JAWS Keyboard Layout 

General 
Key Describer 


Where am I? 


Beginning of Line 


End of Line 


Beginning of File 


End of File 


Beginning of Page 


Delete 


Page Up 


Page Down 


INSERT+NUM PAD 1 

INSERT+NUM PAD 3 

NUM PAD 7 

NUM PAD 1 

CTRL+NUM PAD 7 

CTRL+NUM PAD 1 

ALT+NUM PAD 7 

DECIMAL 

NUM PAD 9 

NUM PAD 3 

Reading Text 
*reading by character is possible only in edit mode 

Read Previous Character NUM PAD 4 

Read Current Character NUM PAD 5 

Read Next Character NUM PAD 6 

Read Previous Word INSERT+NUM PAD 4 

Read Current Word INSERT+NUM PAD 5 

Read Next Word INSERT+NUM PAD 6 
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Read Current Line INSERT+NUM PAD 8 

Read Previous Sentence ALT+NUM PAD 8 

Read Current Sentence ALT+NUM PAD 5 

Read Next Sentence ALT+NUM PAD 2 

Read Previous Paragraph CTRL+NUM PAD 8 

Read Current Paragraph CTRL+NUM PAD 5 

Read Next Paragraph CTRL+NUM PAD 2 

Read from Beginning of Line INSERT+NUM PAD 7 

Read to End of Line INSERT+NUM PAD 9 

Read Continuously INSERT+NUM PAD 2 

Selecting Text 
*selection by character is possible only in edit mode 


Select Prior Character SHIFT+NUM PAD 4 

Select Next Character SHIFT+NUM PAD 6 

Select Prior Line SHIFT+NUM PAD 8 

Select Prior Word INSERT+SHIFT+NUM PAD 4 

Select Next Word INSERT+SHIFT+NUM PAD 6 

Select Next Line SHIFT+NUM PAD 2 

Select to Beginning of Line SHIFT+NUM PAD 7 

Select to End of Line SHIFT+NUM PAD 1 

Select to Beginning of File CTRL+SHIFT+NUM PAD 7 

Select to End of File CTRL+SHIFT+NUM PAD 1 
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Book 26 
Window Eyes Keyboard Layout 

General 
Where am I? 

Speak Key 

Beginning of Line 

End of Line 

Reading Text 

DECIMAL 

ENTER 

NUM PAD 7 

NUM PAD 1 

*reading by character is possible only in edit mode 


Read Previous Character NUM PAD 4 

Read Next Character NUM PAD 6 

Read Current Character NUM PAD 5 

Read Previous Line NUM PAD 8 

Read Next Line NUM PAD 2 

Read Current Line ALT+NUM PAD 8 

Read Previous Word ALT+NUM PAD 4 

Read Next Word ALT+NUM PAD 6 

Read Current Word ALT+NUM PAD 5 

Read from Beginning of Line ALT+NUM PAD 7 

Read to End of Line ALT+NUM PAD 9 

Read to End of Screen ALT+NUM PAD 2 
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